Operation Manual V2.0

Hardware VST Plugin Player
1 Foreword

1.1 Thank You
Congratulations on purchasing the SM Pro Audio V-Machine. You now own an extraordinary product that offers stand-alone playback of VST (Virtual Studio Technology) plugins originally designed for operation on the Windows operating system.

Getting started with the V-Machine is easy. If you’re in a hurry, see Getting Started: Importing & Playing a VST Plugin on page 15.

Even so, we urge you to take the time to at least skim through this manual from start to finish, so you’ll know where to find information when you need it. The SM Pro Audio V-Machine is incredibly versatile addition to your music making tool kit and this detailed manual explains how to make the most its extensive features.

We hope you enjoy making music with the V-Machine!

1.2 Important Notes
Every effort has been made to ensure all information provided in this manual is accurate at the time of writing.

SM Pro Audio is not liable for any incorrect information contained in this manual and makes no warranty in regard to this manual other than as may be required by local law.

SM Pro Audio may update the contents of this manual at any time without prior notice. The latest version of this manual is available from the SM Pro Audio website (www.smproaudio.com) at all times.

1.3 V-Machine Team
SM Pro Audio would like to thank our V-Machine project partners VFX Systems Pty Ltd and Grey Innovation Pty Ltd.

A very big thank you goes out to everyone involved in the V-Machine project: Jim Aikin, Bill Barsby, Joe Berg, Samuel Bolton, Tim Buckley, Vin Curigliano, John Fuller, Denis Greco, Jefferson Harcourt, Peter Howard, Patrick Jose, Brett Kingman, Marcin Koczy, Dr Von K, Mandie Lammens, Leo Lau, Ke Lin, David Lim, Michael Marans, Rohan Mansell, Stephen Marshall, Kade Miller, Owen Neeson, Sam O’Connor, Danny Olesh, Peter Schlossnagel, Cory Seligman, Mathew Skinner, Mike Smith, Chris Steller, Stuart Summerville, Danusia Szafranski, Tamer Terzi, Sandra Terzi, Felix Thiang, Vincent Thiang, Tony Tran, Rowan Vince, Nicola Wong, Yingying Zhang, Stephanie Zhang.
Contents

1 Foreword .............................................................................................................................................. 2
  1.1 Thank You .................................................................................................................................... 2
  1.2 Important Notes ............................................................................................................................. 2
  1.3 V-Machine Team ............................................................................................................................ 2

2 Overview .............................................................................................................................................. 7
  2.1 What’s in the Box ............................................................................................................................ 7
  2.2 Hooking Up the V-Machine ............................................................................................................. 7
  2.3 The V-Machine Hardware ............................................................................................................... 8
  2.4 Front Panel .................................................................................................................................... 9
  2.5 Dual-Press Functions ....................................................................................................................... 10
  2.6 Try It Out! ..................................................................................................................................... 10
  2.7 Memory Types ............................................................................................................................... 10
  2.8 The VFX Application Software ...................................................................................................... 11
  2.9 Software System Requirements ...................................................................................................... 12
  2.10 Installing the VFX Software ......................................................................................................... 12
  2.11 How the Software & Hardware Work Together ............................................................................. 12
  2.12 About VST Plugins ....................................................................................................................... 14
  2.13 Getting Started: Importing & Playing a VST Plugin ..................................................................... 15
  2.14 Getting Started: Exporting a Plugin to the V-Machine ................................................................. 18
  2.15 About Wizard Files ....................................................................................................................... 20
  2.16 Copy Protection ............................................................................................................................. 20

3 The V-Machine Hardware ..................................................................................................................... 22
  3.1 Top Panel ...................................................................................................................................... 22
    3.1.1 Keypad Button User Interface ................................................................................................. 22
    3.1.2 LCD Panel ............................................................................................................................... 22
  3.2 Rear Panel .................................................................................................................................... 23
    3.2.1 Power Connector ....................................................................................................................... 24
    3.2.2 Power Button ............................................................................................................................ 24
    3.2.3 USB Slave Connector ............................................................................................................... 25
    3.2.4 USB Host Connectors ............................................................................................................. 25
    3.2.5 MIDI Input ............................................................................................................................... 25
    3.2.6 Audio Input ............................................................................................................................. 26
    3.2.7 Audio Outputs .......................................................................................................................... 26
    3.2.8 Headphone Amplifier Output ................................................................................................. 26
    3.2.9 Headphone Rotary Volume Control ....................................................................................... 26
  3.3 Kensington Security Slot ................................................................................................................. 27
5.5 Importing Plugins to the Active VFX Library ......................................................56
  5.5.1 Important Preparation & Concepts .................................................................56
  5.5.2 Installing Windows Plugins in the Macintosh ...............................................57
  5.5.3 Plugin Installation Utility ................................................................................57
  5.5.4 More About Wizard Files (Plugin Information File “.vfxwizard”) .....................59
  5.5.5 Plugin Authorization .......................................................................................60
  5.5.6 Installing Plugins on the V-Machine Without the VFX Application ...............61
  5.5.7 VFX Application Main Menu .......................................................................62
    5.5.7.1 File Menu .................................................................................................62
    5.5.7.2 Bank Menu ..............................................................................................63
    5.5.7.3 Preset Menu ............................................................................................63
    5.5.7.4 Plugin Menu .............................................................................................63
    5.5.7.5 V-Machine Menu ....................................................................................64
5.6 V-Machine Pane ..................................................................................................64
  5.6.1 Standard Keypad Browsing .............................................................................64
  5.6.2 V-Machine Global System Settings Menu Icon ..............................................65
  5.6.3 Save Icon..........................................................................................................65
  5.6.4 Learn Icon .......................................................................................................65
  5.6.5 Panic Icon .......................................................................................................66
  5.6.6 Sync Icon ........................................................................................................66
  5.6.7 Help Icon ........................................................................................................66
5.7 Plugin Pane ..........................................................................................................66
  5.7.1 Channel Plugin Slot .........................................................................................67
  5.7.2 Pop-Up Plugin Selector ....................................................................................68
  5.7.3 Plugin MIDI Channel Selector ..........................................................................68
  5.7.4 Plugin Slot Split Selector ................................................................................69
  5.7.5 Mixer Channel, FX Send, and Main Output Selector Tabs ..............................69
5.8 Mixer Pane .............................................................................................................69
  5.8.1 Channel Gain ....................................................................................................70
  5.8.2 Channel Pan .....................................................................................................70
  5.8.3 Channel Mute ..................................................................................................70
  5.8.4 Channel Solo ....................................................................................................70
  5.8.5 Toggle Mode .....................................................................................................71
  5.8.6 FX Sends 1 & 2 ...............................................................................................71
  5.8.7 L&R Audio Input Selector (CAPS) .................................................................71
2 Overview

The V-Machine consists of two components: hardware (the V-Machine itself) and software (a program called the VFX Application). These two components are designed to work together to give you more ways to make music. They don't have to be connected to one another or used at the same time, however. Each can be used by itself.

In this Overview chapter, we'll give you a quick but thorough introduction to the V-Machine and show you how to work with it. The following chapters will provide a complete description of how to operate the hardware and software.

In using the V-Machine, you’ll create sound Libraries, Banks, and Presets in the software and then export them to the V-Machine hardware. Once you've done this, you can take the hardware unit to a concert, club, or recording session and play the sounds you've loaded without the hassle of having to lug a computer around. The V-Machine can also function as an effects processor, thanks to its stereo audio input.

The V-Machine can benefit several types of users: gigging club and worship musicians, DJs wanting to trigger synths and samples live, or a piano bar pianist who wants to shut the lid on the horrible old piano provided by the club and instead play a great-sounding sampled grand on a MIDI keyboard.

2.1 What’s in the Box

When you unpack your new V-Machine, you’ll find:

- The V-Machine hardware unit itself.
- A power supply adapter with AC cord.
- A printed Quick Start Guide.
- A USB cable for connecting your V-Machine to a computer.
- A CD containing the VFX Application software, this manual (in PDF format), and a range of free software plugins to get you started.

2.2 Hooking Up the V-Machine

If you're eager to get started and already have some experience with music technology, you can jump right in and make the connections shown in Figure 1. This figure illustrates the rear-panel connections of the hardware, and also provides a quick overview of how you’ll use the V-Machine with its associated VFX Application software.
An operational overview of the V-Machine. Hardware connections can be made as shown in the lower area. While loading software plugins into the V-Machine, you’ll use the procedural workflow shown in the upper area.

### 2.3 The V-Machine Hardware

The V-Machine hardware is a stand-alone MIDI sound module, with MIDI inputs ready to receive control signals from your keyboard and audio outputs that you’ll connect to a mixer or P.A. system. Traditional MIDI sound modules can do only one type of synthesis (such as sample playback, analog modeling, or FM). The V-Machine is different. Rather than being dedicated to one type of synthesis, it hosts plugin instruments (sometimes called VSTI’s) and effects created by numerous manufacturers in the VST format.

Based on the recently developed *Powered by VFX* embedded technology platform developed by VFX Systems Pty Ltd, Melbourne, Australia, the V-Machine is an extremely versatile musical instrument. By its very nature it can adapt with the push of a button, transforming from a
classic analog synth into a soaring string section, or from a reverb effect to a vocoder.

Traditional hardware synthesizers, samplers, and sound modules are great, but many of today’s software instruments have much more to offer – cutting-edge synthesis technologies, detailed voicing parameters, and more. With literally hundreds of commercial and free VST instruments widely available, the sonic possibilities of the V-Machine are endless.

The V-Machine lets you harness the flexibility of software in a reliable purpose-built hardware unit. Capable of the low-latency MIDI-to-audio throughput demanded by performing musicians, it represents the new breed of technology based music instruments.

2.4 Front Panel
The V-Machine’s front panel (see Figure 2) displays four lines of text, in large letters that are easy to read onstage:

1. The top line shows the currently selected Bank. The V-Machine can contain several Banks of sounds (depending on the amount of memory each Bank requires).

2. The second line shows the currently selected Preset within the current Bank. Only one Preset can be active (producing sound) at any given time.

3. The third line shows the parameter that is selected for editing within the Preset. Most of the parameters of the plugin instruments and effects that you’ve loaded into the V-Machine can be edited directly from the V-Machine’s panel – no need to hook the V-Machine to a computer to edit.

4. The bottom line shows the current value of the selected parameter. If the Parameter in Line 3 is “Patch,” the name of the currently selected Patch is displayed.

5. In addition, the stereo audio input meter, stereo audio output meter, and a system CPU usage meter are visible at the right edge of the display.

![Figure 2](image)

The LCD display and control buttons on the V-Machine.

By pressing the left or right arrow button next to any of the first three lines, you can navigate through the currently available Banks, the Presets within a Bank, the editable parameters of any Preset, and the Patches within a preset. By pressing the left or right button next to the bottom line, you can change the value of the currently displayed parameter.

When you select a new Bank or Preset, you’ll see the words Load and Back in the lower right corner of the display. If you want to load the Preset whose name is displayed in the second line, press the left arrow next to the Load button. If you change your mind, press the left arrow next
to the Back button to return the machine to its former state.

Depending on the size of the Preset you’ve selected, the loading process may take a few seconds. While the loading process is taking place, you'll see a “Please Wait...” message and a simple animated display that indicates the V-Machine’s operating system is busy.

2.5 Dual-Press Functions
A few special functions can be performed by pressing two buttons at the same time. These dual-press functions are labelled to the right of the buttons.

- Pressing the top two buttons at the same time opens the Global System Settings menu. In this menu, you can set the display contrast, change the output level (gain) of the V-Machine, and so on. For details on the Global System Settings menu, see 3.7.1 Global System Settings on page 32.

- Pressing the second pair of buttons together activates the Save function. You'll want to use this if you've changed any of the parameter values in your Presets, so that the edits you’ve made will be restored the next time you turn on the unit or load the Preset.

- After selecting a parameter using the buttons in the third row, you can press both of them together to activate the MIDI Learn function. This function lets you map any parameter to any MIDI control change message. For details on MIDI Learn, see 3.7.3 MIDI Learn Command on page MIDI Learn Command.

- Pressing the two buttons in the bottom row together sends a MIDI all-notes-off message to the instrument(s) in the active Preset. This is useful in the rare situation where you get a “stuck note” because no note-off message was transmitted from your MIDI controller. (This could happen, for instance, if someone trips over the MIDI cable and unplugs it while you’re sustaining a chord.)

2.6 Try It Out!
Your V-Machine comes loaded from the factory with a variety of great-sounding plugins. There’s no need to install the VFX Application software or download and install any VST plugins to start making music with the V-Machine. Just plug it in, turn it on, run a pair of audio cables between its outputs and your sound system (or plug in a pair of headphones), and connect a MIDI keyboard (or some other type of MIDI controller) to the V-Machine’s MIDI or USB input jack.

When you press the power button, the V-Machine will automatically make the Banks from its non-volatile Flash memory (long-term storage) available. The first Preset in the first Bank will be loaded into its RAM (active memory area). After a few seconds, you’ll be able to play the Preset. (Using the V-Machine at a gig is just as easy.) Congratulations – you've just experienced about 1% of the power of the V-Machine.

2.7 Memory Types
The V-Machine has two types of memory. Its Flash memory is for long-term storage – equivalent to your computer’s hard drive. Its RAM memory buffer holds the currently active Preset. Presets can be loaded from Flash, or directly from an attached USB memory device. Currently shipping V-Machine hardware features 1GB of Flash memory and 500MB of RAM.
2.8 The VFX Application Software

After installing the VFX Application on your computer (see Figure 3), you’ll be able to harness the power of the V-Machine by loading a wide variety of freeware and commercial VST instruments and effects plugins into it. For a full explanation of the software functions, see section 5 The VFX Software on page 49. In this overview, we’ll tell you only enough to get you up and running quickly.

The VFX Application is installed from the CD that came in the box with your V-Machine. The software will run either on a Windows PC or on a Macintosh OS X computer. Operations are similar in either case. Where there are differences, this manual will explain them.

Figure 3

The VFX Application software. The upper left area is identical to the front panel of the V-Machine. Presets are designed in the lower left area by inserting VST plugins and setting other parameters. The available parameters of the selected plugin will appear in the large area on the right. The plugin’s graphic front panel can also be displayed.
2.9 Software System Requirements

1. Macintosh: Intel-based Mac. Recommended is at least a 1.5GHz Intel Core processor, 1GB of RAM, and Mac OS X 10.5 or later. Windows VST plugins.

2. PC: Windows XP, Vista, or 7. At minimum, a 1GHz Pentium or Athlon XP 1.33GHz processor and 1GB of RAM. Recommended is a 2.4GHz processor (Pentium or Athlon) and 1GB of RAM.

3. A CD-ROM drive for installation.

4. One or more V-Machine-compatible Windows-based VST plugins.

The V-Machine hardware offers support for a range of Windows VST plugins programmed to operate on the Windows operating system. VST plugins programmed solely for the Mac are not supported.

If your computer is a Macintosh, don't despair! The Mac-compatible version of the included VFX Application offers built-in support for VST plugins originally programmed for use on the Windows operating system. For details on how to load Windows VST plugins using your Macintosh, see 5.5.2 Installing Windows Plugins in the Macintosh on page 57.

VST plugins are readily available from a variety of sources. Commercial plugins are available from music stores and often directly from the developers' websites. Thousands of free plugins are also available for download directly from the many VST resource and community based websites on the Internet.

2.10 Installing the VFX Software

Installing the VFX Application is easy: Just insert the CD-ROM into your computer’s CD/DVD drive and follow the prompts that appear on-screen. In Windows, you will need to open the CD in Windows Explorer and run the VFXSetup.exe program. In the Mac, a startup screen will pop up when you insert the CD; simply drag the VFX Application into the Applications folder.

After installing the software, be sure to check the SM Pro Audio website to find out if there is a more recent version. New versions will be made available from time to time to provide enhanced features and fix any bugs that are discovered. After downloading and installing a newer version of the VFX Application, you may be prompted to update the operating system of the V-Machine. For details on how to do this, see section 3.9 Updating the Firmware on page 40.

2.11 How the Software & Hardware Work Together

In using your V-Machine, you’ll often want to create Presets using the VFX Application software and then load them into the V-Machine for live performance or studio use. For full details on how to accomplish this, please see section 5 The VFX Software on page 49. In this section, we’ll explain the main steps in the process, and introduce some very important concepts.

The VFX Application operates a little differently from most other software that you may have used. Also, its communication with the V-Machine hardware runs in a way that you may not expect. To avoid needless frustration, please start by reading and thinking about the following points.

- Data for the V-Machine is organized in a hierarchy (see Figure 4 below). At the top level are Libraries. A Library appears on your computer’s hard drive as a folder (in Windows) or a bundle (in the Macintosh). Each Library contains one or more Banks, and each Bank
contains one or more Presets. A single Preset has 21 slots for VST plugin instruments and effects.

- A single plugin may, of course, have hundreds of different presets (also known as patches, voices, and sound programs), but these are meaningful only within a single plugin, and should not be confused with the V-Machine’s Presets, though a V-Machine preset may reference a plugin’s patch(es).

- While using the VFX Application, you will always be working within a single current Library. You don’t save or load this Library as you would an ordinary file in another computer program. Instead, you specify the Library you want to use from within the Options (Windows) or Preferences (Macintosh) dialog box. When you save the Preset you’re working on, it will automatically be saved into that Library.

- After creating new Presets, Banks, or Libraries, you’ll naturally want to send them to the V-Machine. There are two ways to do this: Sync and Export. When you use the Sync icon (the word SYNC) in the upper left corner of the software’s main window, data will be sent from the computer to the V-Machine over a USB connection. When you use the Export process, a Library file will be saved to a hard drive or USB memory stick. You can then plug the memory stick (or an external hard drive) into the V-Machine. The V-Machine can load Presets and Banks from the Library on an external USB memory device. When loading from a USB device, Banks on the device are designated by brackets, i.e., [NEW BANK]. Names of Banks in RAM are not bracketed.

**Important:** If you need to install a new plugin in the V-Machine, *exporting is faster.* Generally, you should use the sync option only when the Banks and Presets you’re sending to the V-Machine use plugins that are already installed in the hardware.
2.12 About VST Plugins

Software-based instruments and effects have changed music recording and production in ways that would have been unimaginable only a few years ago. Today, plugin instruments and effects are available in several formats, of which these are the most popular:

- **AU (Audio Unit)** plugins run only on Macintosh computers.
- **DX (DirectX)** plugins run only on Windows computers.
- **RTAS (Real Time Audio Suite)** plugins are compatible only with Avid Pro Tools software, which can run either on a Mac or on Windows.
- **The VST plugin format** is supported on both Mac and Windows.

The V-Machine is compatible with PC/Windows VST plugins. Even the Mac version of the VFX Software uses ONLY PC/Windows VST plugins.

Plugins always operate within a host. Usually the host is some type of multitrack digital audio workstation software, but your V-Machine frees you from the need to use a computer to play VST plugins. The type of plugin you’ll use always depends on what type(s) your host is compatible with, and on what type of computer you’re using. However, many of the plugins that you can buy (or download for free) are available in two or more of these formats. Except for RTAS plugins, which are sometimes available only in the RTAS format, you can usually trust that the plugins you purchase will include VST versions compatible with Microsoft Windows, which means they’re able to run on the V-Machine. (VST plugins that only operate in the Macintosh can’t be used with the V-Machine.)
Before you can run a plugin on the V-Machine, you'll need to go through a special process of exporting it, either directly from the computer to the V-Machine's own memory, or to a USB memory device that you can then plug into the V-Machine. (The latter is usually faster.) Details on how to export plugins are found in section 5.11 Synchronization or Export of the Active VFX Library on page 76.

VST instruments (known as VSTi's) are typically virtual synthesizers or sample-playback modules. They are triggered by notes coming from MIDI controllers or from the MIDI tracks in a sequencer, and they generate audio in real time. The voicing parameters of a VSTi can often be assigned to respond to incoming MIDI controller messages, effectively delivering an experience very similar to what you would get from a hardware synthesizer.

VST instruments are available that provide the sounds of all of the commonly used instrument types. There are VST instruments that specialize in pianos, drums, strings, brass, drawbar organs, and everything through to classic analog synthesizers.

Important Note: Some VST instruments have their own libraries of samples. These libraries can be quite large. In order to use a plugin that has a sample library, you'll need to attach a USB hard drive or memory stick containing the library to one of the USB jacks on the rear panel of the V-Machine.

Other VST plugins operate as effects processors. VST reverb, flangers, delay lines, and compressors are easy to find. With the V-Machine, you can use both instruments and effects in VST format – and even use both in the same Preset. For instance, you could use an electric piano instrument based on physical modeling synthesis and run it through a flanger and reverb. The V-Machine can also be used strictly as an effects processor, thanks to its rear-panel audio input. Signals sent to this input can be processed by the VST effects in a Preset.

### 2.13 Getting Started: Importing & Playing a VST Plugin

If you're itching to get started loading your plugins into the V-Machine, read this section first. If these simple steps don't quite work for you, or don't make sense, you'll need to turn to section 5 and delve deeper into the details. At the end of the list of Getting Started steps, you'll find a short list of things that can go wrong. The process will vary slightly depending on two factors: Whether you're using a Mac or a Windows PC, and (on the PC) whether the plugin is already installed. Here are the steps to take:

1. Install and launch the VFX Application software.
2. Above the mixer section are three Slots for plugins, labelled A, B, and C. Click on the orange triangle at the end of Slot A.
3. From the drop-down menu in Windows, click Import VST Plugin. On the Mac, you will need to choose Run VST plugin installer the first time you want to import a given plugin. (For instructions on how to do this, see section 5.5.2 Installing Windows Plugins in the Macintosh on page 57).
4. The Import VST Plugin dialog box opens (see Figure 5).
The Import VST Plugin dialog box is where you’ll choose VST plugins to import into the VFX Application, and also locate Wizard Files that will insure they’re compatible with the V-Machine.

5. If you have already installed the plugin in your PC, you can choose it from the drop-down “VST Plugin DLL” list.

6. If the plugin you want to import is not installed on your Windows computer, your best option is to take a detour and install the plugin. You may be able to import simple freeware plugins (on either Mac or PC) without installing them, but installing them first is usually a good idea.

7. In the lower field of the dialog box, choose the Wizard File that matches your plugin’s name and version number from the drop-down menu. Before doing this, you may want to click the Check for Wizard Updates button. The Wizard File will be downloaded from the SM Pro Audio website (of course, your computer needs to be connected to the internet). For more about Wizard Files, and what to do if you don’t see a file in this drop-down, see 2.15 About Wizard Files on page 20.

8. If all goes well, you’ll shortly see a dialog box informing you that the plugin has been imported successfully. Click on the orange triangle in Slot A again and select your newly imported plugin from the drop-down menu. It will be inserted into Slot A.

9. Now that you have something to listen to, it’s time to check the status of the VFX Application’s MIDI and audio connections. This is only necessary in Windows, as the Macintosh version handles audio and MIDI connections automatically. In Windows, click on the VFX icon in the upper left corner of the main window (or right-click anywhere on the MENU/SAVE/LEARN button bar) to open the main menu (see Figure 6). From this menu, choose Options.
Figure 6
The main menu of the VFX Application.

10. The Options box will open (see Figure 7) – again, if you’re using a Mac, you can skip this step. Choose the desired audio driver type (such as ASIO) by clicking on a button in the Audio System area. Then choose your audio device from the Playback drop-down menu. In the MIDI-IN box, put a check-mark beside the MIDI input that your keyboard is connected to. For now, we’re not going to worry about the Active Library fields – we’ll return to them later. Click the Close button.

Figure 7
In the Options box, you’ll select the Library folder to use, and also configure your audio and MIDI settings.
11. Make sure that the MIDI channel field next to the plugin you’ve inserted in slot A says “ALL.” Play your keyboard. Depending on the plugin, you may or may not hear a sound: Some plugins make no sound until one of their presets is selected.

12. Go back to the main menu (Remember: Click on the small VFX icon, not on the word MENU) and choose Show VST Editor. You should now see the plugin’s normal graphic edit window in the right-hand part of the main program window.

Select or edit a patch, as desired. If you don’t hear the plugin when you play your keyboard, check your audio system and your MIDI connections. Also make sure that none of the Mute and Solo buttons (the letters M and S) is glowing in the VFX mixer, and that the Gain slider is raised in the mixer channel that your plugin is inserted into. Once you’re hearing the plugin, you’re ready to export it to the V-Machine.

### 2.14 Getting Started: Exporting a Plugin to the V-Machine

When you imported your plugin and assigned it to a mixer slot, you created a basic V-Machine Preset. V-Machine presets reside in a Bank, which resides in a Library. Prior to exporting your Bank, Preset, and plugin to the V-Machine, we’ll need to choose the Library in which to store them. Go back to the main menu and select Options (Windows) or Preferences (Macintosh). If no default location has been entered in the Primary Field of the Active Library box, click the Browse button (in Windows, the Browse button may appear only with three dots, not with the word “Browse”) at the right end of this field. Choose a name and location for your Library. The name should end with the extension .vfxlibrary. Click the Close box.

13. In the main menu, choose Preset > Rename Preset. Give your new Preset a descriptive name.

14. From the main menu, choose File > Save Preset.

15. From the main menu, choose File > Export to VFX Library. The Export to VFX Library box (see Figure 8) will open.

![Figure 8](image)

*The Export box shows where in the active library your new Preset will be stored. If the V-Machine Bank doesn’t*
already contain a copy of the plugin(s) in your Preset, click the With Plugins checkbox.

16. If you want to export your Preset with its associated plugins, check the With Plugins box. When you’re creating your first Preset, you will absolutely want to do this. Later, you may be editing Banks that already contain the plugin(s) in this Preset, in which case it will be faster to leave this box unchecked.

17. Click Export. A file dialog will open. Click Export again.

18. Copy the .vfxlibrary folder from its current location to a removable USB memory device, such as a USB stick or external hard drive. Usually you can do this by dragging it from its current location with the mouse.

19. Safely remove the USB memory device from your computer. Corruption of VFX library files can occur if you do not safely remove USB memory devices from your host computer.

20. Turn on the V-Machine and wait while it powers up.

21. Insert the connector for the USB memory device into a rear-panel USB jack on the V-Machine.

22. Press both buttons in the top row of the V-Machine’s front panel. The System Global Settings menu appears.

23. Press the right arrow button in the top row once. You should now see a screen that begins “Menu: Import.” Press the left arrow button in the third row, beside the word Import.

24. After your plugin Bank is imported, you should see the words New Bank in the top row of the display. The second row should contain the name you gave to the Preset. In the third line, you should see a four-character abbreviation for the name of the plugin (such as acEU for u-he ACE), followed by the name or number of a parameter.

25. Connect your MIDI keyboard to the V-Machine and play the preset.

Okay, that was quite a few steps – but the more you create, save, and export Banks and Presets, the easier it will become.

Hopefully, you’re now able to enjoy hearing your new Preset on the V-Machine. However, several things can go wrong during the process described above. For instance:

If SM Pro Audio has not yet made a Wizard File available for your plugin, the plugin may import successfully in the VFX Application software, but may not be able to operate in the V-Machine.

- If the Wizard File you attempt to use does not match the version number of the plugin, again, the plugin may not work in the V-Machine.

- If the plugin requires more memory than is available in the V-Machine, it may fail to import from the USB memory device.

- If the plugin requires a sample library, this will need to be present on the memory device attached to the V-Machine.
If the plugin requires a hardware USB dongle for copy protection, it will not presently run in the V-Machine. SM Pro Audio is looking into providing support for hardware-based copy protection, and this feature may be added in the future.

If the import process has failed and you are unable to resolve it by checking the above items, consult the troubleshooting guide in Appendix B.

2.15 About Wizard Files
Wizard Files are small text files that give the V-Machine some essential information about how to operate as a host for a plugin. SM Pro Audio maintains, on their website, a large database of Wizard Files for plugins that are known to be compatible with the V-Machine. When you open the Import box (see Figure 5, above) and choose a plugin, the VFX Application will look on the website for the correct Wizard File. For this reason, you'll need to be connected to the Internet when importing plugins into the VFX Application software.

Some plugins will work in the V-Machine without Wizard Files. If the VFX Application doesn’t find a suitable Wizard, you can try selecting “<Don’t use a Wizard File>". This may work, but it may not.

SM Pro Audio may have several different Wizard Files for your plugin. If so, they will probably be identified by software release number (for instance, 1.12.06). It’s important to choose the correct Wizard File for the version of the software that you have installed. In order to find out what version of the plugin you have, you may need to open it in another VST host, such as your sequencer software, and look at its panel or About box. Note that Macintosh users will be unable to do this with the Windows versions of plugins. If you’ve just downloaded the installer for the plugin, the manufacturer’s website will probably tell you what version you’ve downloaded.

If you try to use a Wizard File that is not compatible with the plugin, you may see a message such as “Bad Param Count” in the upper left corner of the VFX Application window. This message will disappear within a second or two, so keep an eye out for it.

To learn which plugins are currently supported with Wizard Files, go to http://www.smproaudio.com/index.php/en/service/wizard-file-database

If the computer you’re using to configure your V-Machine Presets is not connected to the Internet, you won’t be able to update the Wizard database with new versions. Consult the Knowledgebase on the SM Pro Audio website to learn how to download the current set of Wizard Files and make them available on a local computer.

2.16 Copy Protection
Some VST plugins (especially those that are free) are not copy-protected. You can make copies of the actual .dll file that contains the plugin, either as a backup or to share with your friends, and the software in the .dll will run when the plugin is loaded into a host. Most VST’s are copy-protected by the manufacturer, to insure that you’ve paid for the copy that you use. Copy-protected software won’t run unless the copy is authorized.

Several different copy-protection methods are used by various manufacturers. When a piece of software is launched, it will check to see whether this copy is authorized. If no authorization is detected, the software may run in a limited demo mode, or it may not run at all. Some programs, when you install them, store a special “key” file on the hard drive. Usually, this key
file includes information about your computer’s machine ID, a unique number. If the machine ID in the key file doesn’t match the ID of the computer, the software will know that this copy is not authorized. Other plugins check for authorization by looking for a hardware “dongle” (usually a USB device). The dongle must be attached to the computer in order to use the software, and must have a license for the software stored on it. At present, USB dongles are not supported by the V-Machine.

When you load a copy-protected VST plugin into the V-Machine, the plugin needs to determine whether it is authorized to run. If the plugin expects to be authorized using a key file, you’ll need to go through a few steps.

First, the V-Machine will need to be connected to your computer (via USB) when you import the plug-in into the VFX Application. After importing, launch the plugin within the VFX Application by inserting it into a Mixer Slot. At this point, you’ll need to enter whatever code the manufacturer has provided into a text field in the plugin’s interface. The VFX Application will then create an invisible authorization within the V-Machine, so that the plugin will be able to run there.

Even if you have already authorized the plugin to run in your PC, you will probably still need to do a separate authorization for the V-Machine. Some manufacturers of plugins limit the number of authorizations provided to each user. For instance, you may be allowed only two. You might already be using one for your desktop computer and another for your laptop. In this case, you would need to contact the manufacturer of the plugin to request an extra authorization.
3 The V-Machine Hardware

The V-Machine is a compact special-purpose audio processor. It has been designed to interface seamlessly within a wide range of common audio production and performance environments. Much attention to detail has been made to designing a modern, compact, high-performance product that is simple to operate.

The chassis structure of the V-Machine has been designed in such a way as to:

- Provide a powerful yet compact unit suitable for live and studio applications.
- Offer users a simple user interface.
- Allow easy access for connection to peripheral devices.
- Protect the V-Machine’s critical electronics.
- Provide adequate heat dissipation and air flow to the internal electronics.

Many of the common connection options typical of audio processor units can be found on the rear panel, including: Stereo audio inputs and outputs, USB host and slave connectors, a stereo headphone output, 5-pin MIDI input, and a power connector.

The V-Machine is cooled during operation by means of a low-noise internal fan.

3.1 Top Panel

An LCD Panel display and keypad button user interface is provided on the V-Machine’s top panel.

3.1.1 Keypad Button User Interface

The V-Machine’s keypad interface provides a simple mechanism for navigation and control of the V-Machine. The keypads are arranged in four rows of two buttons each.

Single button-presses and combinations (pressing two buttons at the same time) are possible.

3.1.2 LCD Panel

The V-Machine’s LCD panel displays information relevant for navigating and operating the system.

The LCD contrast can be manually adjusted to suit preferred viewing angles. This adjustment is made in the Global System Settings (see section 3.7.1 on page 32). During operation, moving vertical meters will be visible on the right side of the LCD. The meters display the activity on the stereo audio input and output, and also the activity of the V-Machine’s CPU.
3.2 Rear Panel

The V-Machine’s rear panel (see Figure 10, next page) provides connectivity options to facilitate the connection of a range of peripheral devices. From left to right as you face the rear panel, you’ll see:

- The power on/off button.
- A connector for the included power supply.
- Three USB connectors: one for linking the V-Machine to a host computer and two for connecting client devices such as MIDI keyboards and hard drives.
- A MIDI in jack.
- A stereo (TRS) mini-jack for audio input.
- Right and left unbalanced 1/4” jacks for line-level audio output.
- A stereo (TRS) mini-jack output for connecting a pair of headphones.
- A volume knob for the headphone jack.

In the following pages we’ll look at each of these in turn and explain how to use it.
3.2.1 Power Connector
The V-Machine features a power source input connector on the rear panel for connecting the included 12V 2A external 110-240V 50/60Hz plug-pack. The plug-pack is a compact, high-efficiency, low-noise switch-mode design that has been optimized and certified for audio applications.

3.2.2 Power Button
The V-Machine’s power button is located next to the power source input connector. To activate power to the unit, simply press the power button. To turn off the power, press the button again.

Before you turn on the power, check the following points:

- Ensure that all peripheral connections have been made correctly.
- Turn down the volume controls of the amplifier or destination equipment.
● Remove any attached USB memory devices, as the V-Machine will not be able to start successfully when a memory stick or hard drive is attached.

3.2.3 USB Slave Connector
A USB slave connector (the square jack) is provided for connection to a host PC. This is necessary to take advantage of the benefits of configuring the V-Machine directly from your computer. Both synchronization (transfer of Banks and Presets) and updating of the V-Machine’s firmware take place via USB cable. The V-Machine must also be connected when copy-protected plugins are being installed in the VFX Application software, as the software must retrieve a hardware machine ID from the connected V-Machine in order to correctly authorize the plugin.

In addition, the USB slave connector is a MIDI thru connector: It re-transmits MIDI messages received at the V-Machine’s 5-pin MIDI input. This enables the V-Machine to serve as a MIDI interface for your computer, and saves you the trouble of repatching your MIDI system when switching between the V-Machine’s own sounds and those being generated within the computer.

3.2.4 USB Host Connectors
Two USB host connectors are provided for connection to USB peripherals such as USB memory sticks, disk drives, and MIDI controllers. Both host connectors provide USB bus power.

**Important Note:** Each time you attach or remove a USB memory device, your V-Machine will load the first Preset in the first Bank in its Flash memory. Because of this, the USB memory must remain connected at all times while you’re using a Preset that has been loaded from USB. If you plan to use Presets from several different Libraries during a single set at a performance, you’ll want to edit your Libraries so that all of the Presets are in the same Library, as the V-Machine will need a few seconds to switch between USB devices.

If your MIDI keyboard (or other controller) can be used with a Windows computer without installing any special driver software – in other words, if it’s class-compliant – it can be plugged directly into one of the V-Machine’s host connectors. If the keyboard requires a special driver in order to operate in the Windows environment, you’ll probably be able to use it with the V-Machine only by running a cable from its 5-pin MIDI output to the V-Machine’s 5-pin MIDI input. However, some keyboards that are in fact class-compliant still require a driver when used with a Windows computer, so feel free to try plugging yours directly into the V-Machine.

**Note:** USB MIDI controllers and USB hard/flash drives can be safely hot-swapped to the V-Machine at any time after the unit has completed its start-up procedure after being switched on. It’s not necessary to turn off the V-Machine when switching to a different USB device.

3.2.5 MIDI Input
A standard 5-pin MIDI connector is provided on the rear panel for connection to MIDI-compatible devices. The V-Machine responds to note, controller, and program change messages on all 16 MIDI channels. Specific plugins may also respond to special MIDI messages, such as those defined in the General MIDI specification. For details, please contact the manufacturer of the plugin.

**Quick Tip:** If you have a MIDI device that offers both 5-pin MIDI and MIDI over USB, it may be a better choice to connect via USB, as the USB host connectors on the V-Machine deliver bus power. If your MIDI keyboard can use bus power, it won’t need to be plugged into a wall outlet when used with the V-Machine.
3.2.6 Audio Input

One 3.5mm stereo (-10dBV) mini-jack audio input is provided on the rear panel. It provides a 16-bit, 44.1kHz stereo digital signal, which can be processed by plugin effects.

The input level gain can be adjusted in the Global System Settings (see section 3.7.1). Note that this setting boosts or cuts the amplitude of the audio signal after it has been digitized by the V-Machine’s analog-to-digital converter. The input gain is not an analog pad, so if you’re experiencing digital clipping at the input of the V-Machine, you’ll need to attenuate (reduce the level of) the signal at an earlier stage, before it reaches the V-Machine.

Quick Tips:

1. If you’re planning to connect a mono input source for processing, it is a good idea to activate only the left input channel in your Preset configuration. (This corresponds to the signal at the tip of a tip-ring-sleeve plug.) This ensures the processor is not using up CPU cycles processing non-existent data.

2. A meter showing the level of the audio input signal can be seen on the right side of the LCD during operation.

3.2.7 Audio Outputs

Two 6.5mm (1/4”) TS analog (-10dBV) output connectors are provided on the rear panel. These connectors deliver the V-Machine’s stereo analog audio signal. Before being converted to analog, this signal is at 16-bit, 44.1kHz. The left and right outputs are marked for identification.

When the mono output option is activated in the Global System Settings, all audio output signals are summed to both the left and right outputs.

The level of the audio output signal is displayed by a meter on the right side of the LCD.

3.2.8 Headphone Amplifier Output

The V-Machine includes a quality headphone amplifier for monitoring the stereo audio output signal. A standard 3.5mm TRS stereo output connector is provided on the rear panel for connecting a pair of headphones.

The headphone output is designed only to drive headphones. Never connect the headphone output to other peripherals such as a mixing desk, as damage may result to the peripheral or V-Machine.

3.2.9 Headphone Rotary Volume Control

The volume of the V-Machine’s built-in headphone amplifier can be adjusted by rotating the volume knob to your preferred monitoring level. The headphone volume is at maximum when the knob is turned fully clockwise (with reference to a person facing the rear panel).

Always turn down the headphone amplifier volume before connecting and listening to the V-Machine via headphones. Start with the volume control at minimum, and gradually increase the level to an acceptable level. Protect your precious ears at all times!
3.3 Kensington Security Slot
A Kensington Security Slot (also known as a K-Slot or Kensington lock) is part of an anti-theft security system designed by Kensington Computer.

The slot is a metal-reinforced hole found on the front panel of the V-Machine. It is used for attaching a lock-and-cable product that can be purchased from Kensington and through their partner channels. To prevent possible theft of your V-Machine in chaotic stage conditions, attach a locking cable to this slot after looping the cable through something large and heavy, such as a keyboard stand.

More information on the Kensington lock and associated products can be found at the Kensington website (http://www.kensington.com). The Kensington lock is a registered trademark and owned by Kensington.

3.4 Memory Architecture
Maybe the most important thing to understand about the V-Machine is how it handles the data (plugins, Presets, and Banks) that you load into it. The specific commands you’ll need to use for loading, editing, deleting, and so forth are described in the following sections of this chapter. Those commands will make more sense when you understand how the V-Machine’s memory is set up.

The V-Machine has 500MB (megabytes) of RAM (random access memory) and 1GB (gigabyte) of Flash memory. When you play music with the V-Machine, you’re using plugins that have been loaded into RAM. The contents of RAM disappear each time you turn off the V-Machine. The Flash memory, however, is non-volatile, which means its contents will still be there the next time the unit is turned on.

When you use the Import commands to import Banks (each of which will contain one or more Presets, each Preset utilizing one or more plugins) from external USB memory into the V-Machine, the Banks are stored immediately in the Flash memory. After they’re stored in Flash, the first Preset in the first Bank is loaded into RAM so that it will be ready to play.

If there is not enough available space in Flash memory to load the Banks from the USB memory device, you’ll see a warning message. In this situation you’ll need to use the Global System Settings menu (see below) to delete some Banks, Presets, or plugins from Flash memory in order to have space for the new data.

Before deleting anything, you may want to export any Banks whose data you have edited. Use the Export command in the Global System Settings menu for this, and export the Banks to an attached USB memory device.

Instead of importing Banks and Presets from USB to Flash, you can load them directly from USB into RAM. This is convenient, because you can store many more Banks and Presets on a USB hard drive than would fit into the Flash memory.

You can edit the Presets in RAM, using commands described later in this chapter. If you want your edits to be available at your next session, you will then need to use the Save command, which copies the RAM Preset into long-term storage as part of a Bank. The Preset will be copied into the Flash memory if it was loaded from Flash, or to external USB memory if that’s
where it was loaded from.

When you use the buttons in the top row to scroll through your Banks, you'll be viewing both the contents of Flash memory and the contents of the .vfxlibrary folder(s) on an attached USB device. The names of Banks on the USB device are displayed in square brackets, like this: [My Bank].

When you press the Load button, a single Preset from a single Bank is loaded from Flash or USB into RAM. Only one Preset can reside in RAM at any given time.

3.5 Power Up the V-Machine

When the V-Machine is switched on, an initialization progress bar will be displayed along the lower edge of the LCD panel.

The progress bar will advance as the V-Machine loads its firmware. USB peripheral memory devices such as USB memory sticks and disk drives must be disconnected before the V-Machine is switched on, but USB MIDI controllers can be left connected, as can the computer.

As the last stage in initialization, the V-Machine will auto-load the first Preset from the first Bank stored in its Flash memory.

**Special Tip: Changing the auto-load Preset.** If you need to have the V-Machine load some particular Preset of your choosing when first powered on, take these steps:

- After making sure that you have backup copies of all Banks in the internal Flash memory, use the Global System Settings menu to delete all Banks and plugins.

- Create a new Library in the VFX Application, making sure that the Preset you want to auto-load is the first Preset in the first Bank. Or....

- If you already have a Library on your hard drive that you want to use, open its folder in your computer’s operating system, go to the banks folder and renumber the Banks so that the name of the desired Bank begins with the number 000. (Obviously, the Banks should be numbered in sequential order – 000, 001, and so on.) Don’t do this while the VFX Application is running.

- If necessary, use the Clone Preset From command in the VFX Application’s menu to rearrange the order of the Presets within the first Bank.

- Export the Library and import it into the V-Machine.

When the boot-up process is finished, the LCD Panel displays a four-row text display (see Figure 2.3). In the display you’ll see:

- The name of the currently active Bank.

- The name of the currently selected Preset within the Bank.

- The plugin parameter within the Preset that is currently selected for editing.

- The current value of the parameter (as a number or as a word, such as On or Off).
3.6 Using the Left/Right Buttons

You can navigate the V-Machine using the keypad button user interface. By pressing a left-arrow or right-arrow button, you can step through the functions in the corresponding line of the LCD. In addition, the two left-arrow buttons at the bottom are used as command buttons when commands are displayed next to them. (The dual-button-press functions are described in a later section of this chapter.)

3.6.1 Bank Left/Right

Use the left (previous) and right (next) buttons in the top row to navigate through the Banks (collections of Presets) stored in your V-Machine and on an external USB memory device.

Quick Tip: For speedy access to Presets during a performance it may be useful to store Presets in Banks according to the order you plan on performing them. For example: A Bank named “Song1” might include all the Presets you will use in song 1. To change the order of Banks and Presets, follow the steps listed in section 5.10.2 on page 74. It is not possible to change the order of Banks and Presets once they have been loaded into the V-Machine.

When you select a Bank and press Load, the first Preset residing in that Bank, whose name is shown in the second line, will be loaded. You can press the left or right arrow in the second row to choose a different Preset before pressing the Load button.

Bank navigation/selection can also be accessed via a MIDI controller by assigning these buttons using Global MIDI Learn in the Global System Settings menu, as described in section 3.7.1.4 on page 35. This lets you load new Banks (and Presets, as described in the next section) by remote control – from your MIDI keyboard in performance, for example. You can also select Banks by sending MIDI Bank Select messages, as described in section 3.7.1.3 on page 34. It’s important to understand that when you select a Bank (or a new Preset within the current Bank), it may take a few seconds for the Preset to load.
During that time, the V-Machine will make no sound. See the next section for more on this.

3.6.2 Preset Left/Right
Use the left (previous) and right (next) buttons in the second row to scroll through the Presets (mixer configurations and associated plugins) within the currently selected Bank.

Special Note: When using a Preset for the first time after booting the V-Machine there will often be a short delay as one or more plugins are loaded into RAM. Once the plugins are loaded, if you later select a different Preset that contains the same plugin(s), the new Preset will be loaded with little or no delay.

Instead of using the left/right arrow buttons to select Presets, you can send MIDI program changes to the V-Machine from a MIDI keyboard. When the V-Machine receives a program change message on the Mixer channel it will check to see whether a Preset with a corresponding number is available in the current Bank. If so, it will prepare to load the Preset. At this point you can either press the front-panel arrow button next to the word Load, or control the Load button remotely using MIDI. Instructions for how to do the latter are found in the section on Global MIDI Learn (section 3.7.1.4, page 35).

3.6.3 Parameter Left/Right
Use the left (previous) and right (next) buttons in the third row to navigate quickly through the editable plugin parameters of the currently selected Preset. You will only see parameters that are active. For example, if you have no effects plugins inserted in the FX1 or FX2 bus as explained in section 5.8.6 on page 71), the Send knobs for the Mixer channels will not be listed among the editable parameters. But if an FX bus is active, its Send knob level will appear among the parameters for any mixer channel that has a plugin in any of its slots.

Quick Tip: As some plugins have literally hundreds of available parameters, you may want to prioritize the order of the parameter list for speedy access. Priority parameter assignments can be configured for each Preset in the VFX Application as described in section 5.9 on page 73.

Parameter navigation/selection can also be accessed via a MIDI controller using the V-Machine’s Global MIDI Learn feature (found in the Global System Settings menu), as described in section 3.7.1.
3.6.4 Value Left/Right

Use the left (previous) and right (next) buttons in the bottom row to adjust the value of the parameter selected in the third row up or down as desired.

Quick Tips:

- Press and hold the Previous or Next button to scroll the up/down value with greater speed.

- You can map your favorite parameters to knobs and faders on an external MIDI controller for hands-on access to multiple plugin parameters using the dual-press MIDI Learn feature, as described in section 3.7.3 on page 38.

- Value adjustments can also be accessed via a MIDI controller by assigning the value to Global MIDI Learn (found in the Global System Settings menu), as described in section 3.7.1.4 on page 35.

3.6.4.1 About Mute and Mute (T)

Most of the parameters found in the V-Machine’s panel either relate to a specific plugin, or are Mixer settings whose meanings will be instantly clear to anyone who has ever used an audio mixer. For information on the parameters specific to a plugin, you’ll need to consult the owner’s manual for the plugin. However, two of the Mixer parameters require a bit of explanation.

The V-Machine provides two ways of muting and soloing its Mixer channels. You can use the Mute and Solo parameters, or use Mute(T) and Solo(T). When used from the front panel, they function identically. However, they respond differently to MIDI control change messages when assigned using the Learn command.

The (T) stands for the word “toggle.” A toggle is a switch that turns on and off. But the normal Mute and Solo parameters are toggles, so how are Mute(T) and Solo(T) different?

To observe the difference, first select Mute(T) for a channel that has an active instrument in it. Then press the Learn dual button command and move your keyboard's mod wheel to assign mod wheel (CC1) messages temporarily to Mute(T). Move the wheel upward very slowly, while playing the keyboard. You will hear the channel being muted and unmuted repeatedly. Each time a new CC1 message is received, the channel will be alternately muted (if it is currently not muted) or unmuted (if it is currently muted). The channel’s mute status is toggled by each CC1 message it receives. This makes it useful with MIDI-assignable buttons that transmit a single control change value each time they’re pressed.

To continue exploring this feature, next you should unlearn this assignment:

- Make sure Mute(T) for this channel is selected as the parameter.
• Press both arrow buttons in the third row to activate the Learn function.

• Press the left arrow beside the word Unlearn.

Now we’re going to look at the ordinary (non-T) method of controlling the Mute parameter. Select the ordinary Mute parameter for the channel, use the dual-button Learn command, and wiggle your mod wheel again. At this point, CC1 messages with values of 0 through 63 (the lower half of the mod wheel’s travel) will turn the parameter to Off. That is, they will unmute the channel. When you push the mod wheel up so that it’s in the top half of its travel, the channel Mute parameter will switch to On, because a CC1 message with a value between 64 and 127 is being received.

### 3.7 Dual Button-Press Functions

By pressing two buttons at once, you can access the functions labelled to the right of the pairs of buttons. Note that if the system is waiting for you to press one of the command buttons (Load and Back will be shown in the lower right portion of the display), three of the four dual button-press functions will not be available. Only the Panic (MIDI all-notes-off) function will work.

#### 3.7.1 Global System Settings

Pressing the two buttons in the top row, adjacent to the MENU label, opens the V-Machine’s Global System Settings menu. When you first press these buttons, you’ll see the words “Menu: System Info” in the top line. You then use either the left or right arrow button to navigate through the Global System Settings menu.

The Global System Settings (described in detail on the next few pages) are as follows:

- Display (LCD contrast).
- Audio Options (output mono/stereo, input gain, and output gain).
- MIDI Options.
- Global MIDI Learn: options to control the V-Machine hardware remotely via MIDI.
- System Info: A read-only display of firmware (operating system) version number and memory usage.
- Import: commands for importing Banks to the internal Flash memory from a VFX Library folder on an external USB memory device.
- Export: commands for exporting internal Banks to a VFX Library folder on an external USB memory device.
- Delete: commands for deleting Presets and Banks from Flash memory.
- Delete Plugins: commands for deleting a single plugin from Flash memory.

The settings can be adjusted using the left/right arrow buttons next to the items. In the Import page, for instance, pressing the left and right arrows in the second row lets you choose whether to import a single Bank, a single Bank with its plugins, all Banks, or all Banks with their plugins.

To exit the Global System Settings menu at any time, press the left arrow next to the word “Back,” in the bottom row of the LCD.
3.7.1.1 Menu – LCD Display
The LCD display contrast setting can be adjusted to suit varied lighting conditions and viewing angles. Use the left/right buttons to the right of the Contrast parameter to adjust the contrast in percentage terms.

3.7.1.2 Menu – Audio Settings
The audio settings offer three configuration options. Choose Output, Input Gain, or Output Gain as needed using the left/right arrow buttons in the second row.

I. Output. The V-Machine’s audio output can be set to either mono or stereo. Some plugins only operate in mono. If you’re using one of these, it may be desirable to output the same mono signal from both physical outputs. It may also be necessary to send an identical mono signal from both outputs so you can send the same signal to an amplifier for monitoring and to the front-of-house mixer in performance situations.

Use the left/right buttons in the third row to toggle the setting from stereo to mono.

II. Input gain. The V-Machine’s audio input gain can be adjusted to accommodate differing input signal levels. This is very handy when using the V-Machine as a real-time audio processor (effect unit).

Use the left/right arrow buttons adjacent to the Input Gain label to adjust the input level up or down in 1dB steps. This parameter can be set from 0dB to +35dB. If you’re sending a low-level signal to the V-Machine, you may need to raise the input gain parameter to insure that the signal is loud enough when it reaches your effects plugin(s). Conversely, if the signal is already at a high level, you may need to reduce the input gain in order to avoid overdriving the effect plugin(s), which would result in distortion.

Quick Tips: With some effects plugins, setting the input too low may result in extra noise being added to the signal. If the output of the plugin is low and needs to be boosted, you should try lowering the output and raising the input gain instead, as this may allow the plugin to work more efficiently. On the other hand, if you hear clipping distortion, check the input gain to see if it can be lowered, as this may eliminate the clipping. Note that the input gain parameter is not an analog pad; it adjusts the level of the input signal only after the signal has been converted to digital. If you hear clipping distortion that isn’t removed by lowering the input gain parameter, try lowering the level of the analog audio signal being sent to the V-Machine.

III. Output gain. The output gain can be set from -42dB to +14dB in 1dB steps. This parameter is, in effect, the V-Machine’s volume knob. It affects both the line outputs and the signal sent to the built-in headphone amp. (The headphones also have a volume knob.)

Quick Tip: To maintain optimum headphone output level, you may prefer to keep the output gain parameter up at a high level and reduce the level of the V-Machine’s signal...
in your mixer or stage amp. If you hear distortion in the output, however, you should try lowering the output gain to see if this resolves the problem.

### 3.7.3 Menu – MIDI Options

The MIDI options offer the following possibilities:

- **Send Program Change.** This can be set to "to Preset, then Plugins" or "to Plugins Only".

  By sending MIDI Bank Select and program change messages from a connected MIDI controller, you can change the current Bank and Preset of the V-Machine. This can be handy if the V-Machine is being controlled by a sequencer, or is not within reach to click the keypad buttons manually.

  Please refer to your MIDI controller’s manual for information on how to transmit MIDI Bank Select and program change messages.

  If set to "to Preset, then Plugins": Bank and program change messages will change the active VFX bank and preset if they come in on a channel accepted by the VFX mixer. A bank change will only be confirmed if followed by a program change. If the VFX mixer does not receive the message, then it will be forwarded to all loaded plugins. If there is only one VFX preset in the active VFX bank, then the program change will be sent to the first plugin in that preset.

  If set to "to Plugins Only": All bank and program change messages will be sent to all plugins that are receiving on the channel of the bank or program change message. Bank and program change messages will never change the active VFX bank or preset.

- **Program Change Delay.** This parameter can be set to Never Change, Immediate, or a time value between 0.1 and 7.0 seconds. If it’s set to Never Change, program change messages will be ignored, even though they have been given a destination by the Send Program Change parameter. If Program Change Delay is set to Immediate, program changes will be responded to instantly. Setting a delay time is equivalent to calling up a new Preset and then waiting a few seconds before you press the Load button. A delay time can be useful if you have to make several changes in your equipment setup quickly between songs.

- **Parameter Feedback.** The V-Machine's parameter feedback can be turned on or off. Parameter feedback is especially useful when using external motorized MIDI controllers, or controllers whose knobs are ringed by lighted LEDs. Motorized faders and LED-encoded pots need to update to the correct positions when Presets are changed on the V-Machine. For this function to work, you’ll need to do three things. First, you’ll need to be using a controller that has motorized faders or LED-ringed knobs, so that it can respond to the V-Machine’s MIDI output. Second, this controller will need to be connected to the V-Machine using USB, because the V-Machine’s MIDI output is sent via USB. Third, you’ll need to use the V-Machine’s MIDI Learn feature (see section 3.7.3, page 38) to create a linkage between specific parameters and specific controller messages. Once the linkages have been created and saved to the Preset, each time the Preset is loaded, the values of the linked parameters will be sent to the V-Machine’s USB MIDI output. Assuming your hardware controller’s knobs and faders respond to the
same MIDI messages that they transmit, they will recognize the incoming messages and set themselves appropriately.

3.7.1.4 Menu – Global MIDI Learn

The MIDI Control section of the Global System Settings offers the ability to configure external MIDI control of the V-Machine’s button interface, functions, and other useful settings. The control assignments you set up here will allow you to remote-control your V-Machine button interface from an external MIDI controller.

MIDI-controllable buttons, functions, and settings include:

- Bank “knob”
- Preset “knob”
- Parameter “knob”
- Value “knob”
- Menu button
- Save button
- MIDI Learn button
- Panic button
- Accept (same as Load) button
- Back button
- Mono Out setting

Although the V-Machine has no physical knobs, the first four items give you the ability to scroll left and right using the associated arrow buttons, exactly as if you were turning a knob.

After accessing the MIDI Control section, use the left/right arrow buttons in the second row to scroll through the available MIDI-controllable functions. Once you have selected the function you want to control remotely, you can select the CC message that you want to use manually, using the arrow buttons in the third row, or you can send a MIDI CC control signal from your MIDI controller. The V-Machine will recognize the incoming MIDI signal and assign the control to the selected function on your MIDI controller. These assignments are in MIDI omni mode, so the V-Machine will respond no matter what MIDI channel the messages are on. For instance, if you assign footswitch message CC66 as the Panic Button, an incoming CC66 message will trigger the Panic Button command (thus shutting off any sounding notes), no matter which of the 16 MIDI channels the message is on.

Special Note: The MIDI control in this section refers to the V-Machine’s hardware control (the V-Machine buttons and settings). Plug-in parameter control can also be configured individually on a per-Preset basis, giving you hands-on control of the important parameters of each plugin. The latter function is explained below, in section 3.7.3.

3.7.1.5 Menu - System Info

The System Info page provides the following (read-only) information:

I. The V-Machine’s current firmware version. Updates to the V-Machine firmware are released periodically and include bug fixes, improvements, and new features. If your V-Machine’s firmware version is older than the current version shown on the SM Pro Audio website, you’ll need to update to the new version. See section 3.9 on page 40 to learn how to do the update procedure. Being able to check your firmware version is also useful when you need
to provide system information because you’re in need of technical support.

II. *The Internal Flash memory (1GB) storage status.* The Disk percentage (%) tells you how much of your Flash memory is currently being used to store Banks. This information is very useful when considering how to best allocate memory requirements. If you need to clear out one or more Banks in order to have room to import other items, use the Delete function. See section 3.7.1.8.

III. *The RAM memory usage.* This percentage tells you how much of the 500MB of RAM is being used by the currently active Preset.

#### 3.7.1.6 Menu – Import

It is possible to import VFX Library components from a USB memory device into the V-Machine’s internal Flash (long-term) memory. The following options are provided: Bank, Bank + Plugins, All Banks, All Banks + Plugins.

If you choose an import option that includes importing plugins, it will overwrite any versions of the same plugin that may already reside in the Flash memory. If a plugin has been updated by the manufacturer, overwriting the old version with the new one may affect the sound of other Presets, so this situation needs to be managed with care.

If you want to import a single Bank, before entering the Global System Settings menu you will need to browse to that bank on the external USB memory, using the buttons in the top row. The name of the Bank will be surrounded by square brackets, like this: [MyBank]. Load a Preset from that Bank, and then enter the Global System Settings menu. Now you can select Bank in the Import menu, and the selected Bank will be copied from the external library into the Flash memory.

#### 3.7.1.7 Menu – Export

It is possible to Export VFX Library components from the V-Machine’s Flash memory to a USB device. The following options are provided: Bank, Bank + Plugins, All Banks, All Banks + Plugins. After navigating to the Export page in the Global System Settings menu, choose the desired option and then press the left arrow next to the word “Export.”

Exporting from the V-Machine is only possible when you have a USB memory device connected. The V-Machine will export your selection to a VFX Library folder on the USB memory device with the name ‘V-MACHINE.vfxlibrary’ in the top (root) directory on your USB memory device. If you already have a folder by that name in the root directory of the device, the Exported items will be added to that Library.

The main reason to export a Bank that you imported to the V-Machine in the first place is because you may have edited one or more of the Presets in the Bank using the V-Machine’s front-panel controls. By exporting the Bank to external memory, you create a copy that can be kept in long-term storage. After reconnecting the USB memory device to your computer, you may want to change the name of the exported Library to remind you of the edits that you’ve made.

#### 3.7.1.8 Menu – Delete

The Delete function on the V-Machine hardware only deletes Library components stored in the
1 GB internal Flash memory. It does not delete Libraries or Library components stored on external USB connected media. To delete Libraries and the files within them, attach the USB media to your computer and use your computer's operating system.

The Delete Menu in the V-Machine allows you to delete a single Preset, a single Bank, All Banks, or All Banks + Plugins. If you want to delete a single Preset or Bank, you must select it (by loading it) in the V-Machine’s main screen before entering the Global System Settings menu. If an external Bank is selected, you will not see the option to delete a single Preset or a single Bank. In this situation, your only choices will be to delete All Banks or All Banks + Plugins.

**Important Note:** Even if an external Bank is active when you enter the Global System Settings Menu to use the Delete commands, these choices refer to the internal Flash memory, not to the external Library — so use the Delete command with care.

Use the arrow buttons in the second row to select the desired Library component to delete. Press the third left arrow (by the word Delete) and then confirm the operation by pressing it again in response to the message “Really Delete? OK”. If you change your mind, simply press Back or Cancel, as needed.

It is important to understand what is actually deleted. For example, deleting a Preset only deletes the Preset information, but not its associated plugin(s). This is because there may be another Preset that uses the same plugin! If you want to delete a plugin, see section 3.7.1.9.

**Delete Preset** – This option deletes the currently selected Preset only. All plugins used in the Preset remain, in case they’re being used by other Presets.

**Delete Bank** – This option deletes the currently selected Bank and all Presets within it. Again, all associated plugins used in the deleted Presets will remain in memory, in case they’re being used by Presets in other Banks.

**Delete All Banks** – This option deletes all Banks and all Presets. All of the plugins stored in Flash memory will remain available, however, so that they can be used when new Banks and Presets are loaded.

**Delete All Banks + Plugins** – This option completely clears the V-Machine’s internal Flash memory storage. All Banks, Presets, and plugins are deleted. This is essentially a complete format of the V-Machine’s internal memory.

Pay due consideration to what you delete. If you’ve edited a Preset and saved it to Flash memory, by deleting it you may lose a great sound forever!

---

**3.7.1.9 Menu – Delete Plugins**

The delete plugin option allows for selection and deletion of plugins from the V-Machine’s internal Flash memory.

Use the left/right arrow buttons in the second row to select a plugin for deletion. Once this is selected, press the keypad button adjacent to the Delete label, and confirm by pressing the keypad button adjacent to the OK label. If you change your mind, press the button next to Back or Cancel.

**Quick Tip:** If you have enough memory available in either internal or external Flash storage locations, it can be very convenient to leave plugins there. Often many of your Presets will use
the same plugin, so it doesn't make sense to continually transfer or delete the actual plugin (and associated files, samples, etc.) as you make new Presets. Synchronizing a new Preset to the V-Machine from the computer or importing from USB memory will proceed much faster if the plugin is already stored in the V-Machine.

During synchronization over USB, you are given the option to synchronize with or without plugins. You can also choose to leave or overwrite plugins if they are already on the V-Machine. For details on this process, see section 5.11.1 on page 77.

**3.7.2 Save Command**

Pressing the two buttons in the second row, next to the word SAVE, activates the Save command.

The Save command saves a snapshot of the currently active Preset, including all parameter values, to its original location. If it was loaded from Flash memory, your edits will be saved to the Flash memory location. If it was loaded from a Library on an external USB device, the edited version will be saved to that Library.

The Save command can also be accessed via a MIDI controller as described in section 3.7.1.4.

**3.7.3 MIDI Learn Command**

Pressing the two in-line keypads adjacent to the LEARN command label activates the MIDI Learn command. The Learn command is used for assigning plugin parameters to external MIDI controllers. This is a great way to have hands-on control of your sounds in performance.

To use this function, follow these steps:

- Make sure you have the plugin parameter selected that you wish to assign to an external MIDI knob/fader.
- Activate the Learn function.
- Move the controller knob/fader on your connected MIDI controller.

The plugin parameter has now been assigned to receive MIDI control messages from your chosen controller.

The V-Machine allows you to assign as many parameters as you’d like to a single controller. This can be a powerful feature – for example, you could open up a synthesizer's lowpass filter while also panning its signal from left to right. However, this power opens the door to possible confusion. For best results, assign only one parameter to each of the hardware knobs or sliders on your controller. If you want to use a knob or slider for a different function in the same Preset, first select the parameter that is currently being controlled by the knob or slider, then use the dual-press Learn command, and finally press the left-arrow button next to the word Unlearn.

*Quick Tip:* If you wish to be able to use the assigned MIDI control message the next time you
load the Preset, you should also save the Preset after using the Learn command to create the new assignment.

It can be very handy to scroll through a plugin’s internal patches using a rotary encoder on your MIDI keyboard rather than using the buttons on the V-Machine. To do this, use the left/right arrows in the third row (while the V-Machine’s main screen is visible in the LCD) to locate the Patch parameter. Then use the dual button-press to activate the Learn function and move the controller that you want to be your patch selector. Note, however, that the Patch parameter does not function with all plugins, even those that may have internal memory banks containing multiple patches.

The LEARN command can also be accessed via a MIDI controller by assigning it to Global MIDI Learn in the Global System Settings menu. In effect, this is a way of changing the MIDI Learn assignments on the fly, under remote control. There’s definitely some potential for confusion, so this advanced feature should be used with care.

### 3.7.4 Panic Command

The dual keypad press Panic command has three functions:

- Pressing the two in-line keypads adjacent to the word PANIC is a MIDI Panic button.

The MIDI Panic command sends an all-notes-off MIDI message to the V-Machine engine. This may be necessary to eliminate troublesome “stuck MIDI notes,” which can sometimes occur with various combinations of MIDI controllers and VSTi plugins.

The MIDI Panic command can also be sent using a MIDI controller by assigning it in the Global MIDI Learn utility in the Global System Settings menu.

- These buttons transmit an emergency hardware reset command during startup. If during the boot stage of power-up, your V-Machine hangs, which might happen if a failed or bad plugin is not loading correctly from Preset 1 of the first Bank, you can use the Panic button combination to disable loading of the bad plugin and continue. You can then delete the offending Bank, Preset, or plugin using the Delete and/or Delete Plugins commands in the System Global Settings menu.

- Escaping the hardware GUI screen of a plugin that takes advantage of the V-Machine’s LCD panel to display its own custom graphics. An example of this is the True Pianos acoustic piano plugin. This plugin utilizes the V-Machine’s LCD to display a custom interface to the user. You can use the Panic command to exit the plugin’s GUI and return to the standard V-Machine operational interface.

### 3.8 External USB Memory Devices and the V-Machine

Using USB memory devices (Flash/HD) with the V-Machine can increase the number of Banks, Presets, and plug-ins accessible at any one time. Such devices offer additional storage beyond the V-Machine’s internal Flash memory capacity.

VFX Library files (which are created in the VFX Application software, as explained in Chapter 4 of this manual) must be located in the top directory of USB external media devices to be recognized and loaded by the V-Machine hardware.
USB memory devices can be hot-swapped to the V-Machine’s USB ports at any time after the V-Machine has successfully completed its boot process. USB power enables use with small portable USB 2 hard drives (tested up to 250GB).

The V-Machine does not distinguish between VFX Banks that are stored in its internal Flash memory and those stored on external USB media devices. Any VFX Libraries found either internally or externally are merged into one VFX Library file as far as the V-Machine is concerned. The only exception to this rule is when operating the Delete function, which can only be used to remove items from the internal Flash memory of the V-Machine. To delete items from an external Library, connect the drive or memory stick containing the Library to your computer, and use your computer’s operating system to manage the Library folder.

Once a USB device has automatically mounted on the V-Machine, any Banks, Presets, and plugins present in its Libraries will be made available for musical use. Scroll through the Banks on the V-Machine as usual to discover the newly available Banks.

All Banks accessed from external memory devices will be displayed on the V-Machine's LCD Panel surrounded by brackets. For example, a Bank named Pianos will be displayed as [Pianos] on the LCD.

**Important Tip!** – Always safely remove USB memory devices from your host computer to avoid corruption of VFX libraries. A corrupted library will not work successfully on the V-Machine.

### 3.8.1 Importing a Bank from USB Media to the Internal Flash Memory

It is possible to import Banks from VFX Libraries stored on USB memory devices to the V-Machine’s internal Flash memory. This is useful if you have some favorite Presets that you would like to be available at all times in the V-Machine after boot-up. The main limitation to be aware of is that the files you import cannot exceed the 1GB size of the Flash memory.

To import a Bank from a connected USB memory device:

1. Select the Bank in the LCD. (Its name will be surrounded by brackets.)
2. Enter the Global System Settings Menu by pressing the two Menu buttons together.
3. Use the left/right arrow buttons in the top row to scroll to the Menu: Import option.
4. Choose Bank, Bank + Plugins, All Banks, or All Banks + Plugins using the left/right arrows in the second row.
5. Press the button beside the word Import to import the item(s), or the button beside the word Back to cancel the operation.

The item(s) you have chosen will be transferred to the V-Machine’s internal flash memory and merged into the V-Machine’s internal VFX Library. If you do not have enough memory available on the internal Flash memory to import the selected Bank, the import operation will not take place.

### 3.9 Updating the Firmware

From time to time, SM Pro Audio may release a newer version of the V-Machine operating system (its firmware). If your software installation (the VFX Application) is up to date, when you turn on the V-Machine while the VFX Application is running or launch the Application while the V-Machine is connected, the VFX Application will detect that your firmware is out of date and request to update it. When the VFX Application detects that the firmware needs to be updated, you will see a dialog box that provides instructions.
To update the firmware, proceed as follows:

- Make sure the V-Machine is connected via USB to the computer, and that the VFX Application is running. If the VFX Application is displaying a dialog box telling you that you need to update the firmware, close the dialog box.

- Hold down both Learn buttons while you switch on the V-Machine. When the V-Machine finishes booting up, it will be in Update Mode.

- A dialog box on the computer will ask if you would like to update the firmware only, or also format the V-Machine’s Flash memory (see Figure 20 below). If you choose to format the Flash, you will then need to reinstall any Banks that you want to be available from Flash. To reinstall the Banks, connect a USB drive or memory stick containing the Banks to the V-Machine and then use its Import All Banks and Plugins command, as explained above in Section 3.8.1.

- You will see a percentage figure on the LCD, which shows how the update is progressing. Don’t turn off the V-Machine, quit the VFX Application software, or unplug the USB cable until the update process is completed.

When the update is completed, turn your V-Machine off and back on again.

![Figure 20](image)

A dialog box in the VFX Application will ask what you would like to do while updating the V-Machine's firmware.

### 3.10 Safety instructions

- Retain all safety and operating instructions for future reference.

- Follow all installation and operating instructions.

- Unplug the V-Machine from the AC power outlet before cleaning.

- Use only a soft cloth for cleaning the exterior of the V-Machine.

- Do not expose the V-Machine to water or moisture.

- Do not place the V-Machine on an unstable surface.

- Do not obstruct the air ventilation slots on the side of the V-Machine.
● Never place the V-Machine near or over a radiated heat source.
● Do not place the V-Machine in an enclosure without proper ventilation.
● Do not stack the V-Machine below other electronic devices.
● Only use the included plug-pack.
● Never insert objects of any kind into the V-Machine through the ventilation slots.

3.11 Temperature operation
The V-Machine operates at temperatures between 0° and 40°C.

3.12 Hardware Specifications
Hardware specifications are available on the SM Pro Audio website (www.smproaudio.com).
4 Plugins Included in Your V-Machine

When you unpack your V-Machine and plug it in, you'll find a solid selection of plug-in instruments already installed and ready to use. The collection includes a good acoustic piano, a selection of sampled drums and other instruments, and a number of digitally modeled analog-type synthesizers with various features. In this chapter, we'll take a quick tour of the included plugins.

You can edit most of the parameters of most of these plugins from the V-Machine's front panel. But the most convenient way to edit the Presets that use the plugins is in the VFX Application software. (Using the software is explained in section 5 of this manual.) Editing the plugins from their graphic panels within the VFX Application is really the best way to understand what the various features and functions are. Explaining the details is beyond the scope of this manual.

The plugins included with the V-Machine are both pre-loaded into the hardware and available on the CD-ROM. The easiest way to edit the plugins using the VFX Application is to install them from the CD-ROM to your computer. Then import them into the VFX Application, as explained in Chapter 4. After creating an edited version of the Library, you can export it or sync it with the V-Machine. Once you've done this, your edited versions will be playable directly from the V-Machine.

Note that most of these plugins can't save their own patches. However, any edits you make in the sounds can easily be saved into your V-Machine Presets. After installing the plugins from the CD-ROM into your Windows computer, you'll be able to use them in any VST-compatible host program. However, you won't be able to load the sounds made by the plugins within your VFX Presets into your own VST-compatible host software unless the plugin is able to export its own patch data in some file format.

For details on the features of the plugins, you'll need to consult the manufacturers. (Contact information should be available on their websites, which are listed below.) In this chapter we'll provide only a quick overview.

4.1 The Instruments

The plugins in the installed Library are conveniently set up with one in each Bank. You can call them up by using the Bank left/right arrow buttons. Here's what you'll find at the time this manual was produced:

**AlgoMusic Phadiz.** Though simpler in concept than the fabled Casio CZ-101, Phadiz uses the same type of phase-distortion-based digital synthesis to produce some tasty vintage tones. A peculiarity of this synth is that both oscillators are heard at all times: The mixer doesn't reduce their levels to zero. (For more information, visit www.algomusic.net/freeware.html)

**AlgoMusic String Synth.** An analog-style string machine with a nice rich sound.

**AlgoMusic SynthEdit Arpy.** A very basic synthesizer voice, enlivened by the built-in arpeggiator.

**ElektroStudio DavoSynth.** This emulation of a classic electric organ design uses an octave at the left end of the keyboard for real-time control of articulations. The plugin is monophonic;
that is, it can't play chords. (For more information, visit www.elektrostudio.ovh.org/index2.php.)

**ElektroStudio MicroMoon.** A single-oscillator analog-style synth whose design was inspired by the MicroMoog. The envelopes use switches rather than a full ADSR shape, but the filter sounds nice and rich.

**ElektroStudio Moon Sono SX.** The vintage duophonic keyboard mode on this analog-style synth is unusual – and like the hardware analog instruments of the '70s, it has an audio input, allowing its filter or ring modulator to be used as an effect processor. The effect will be gated on and off by MIDI notes on the receive channel that you specify in the VFX Application’s Mixer slot.

![Figure 21](image)

**The Moon Sono SX 2 from ElektroStudio has two oscillators and an unusual setup that allows its envelope generator to be gated from two LFOs at once.**

**ElektroStudio Ocot.** This six-channel analog drum box is very interactive. After setting up some patterns using the graphic editor in the VFX Application (and saving the Preset to your Library), you can switch patterns from a MIDI keyboard while the music plays.

**ElektroStudio ODsay.** Closely patterned after the ARP Odyssey, this virtual analog synth has switchable signal routings and a duophonic keyboard mode.

**ElektroStudio OR2V.** Two voice modules and a dual eight-step pitch sequencer are the main features of this analog-style synth, which bears a passing resemblance to an Oberheim Two-Voice system.

**ElektroStudio Rhythmus.** It doesn’t get much more vintage than this drum box, which sports 12 non-editable analog percussion sounds and 20 preset rhythms.

**ElektroStudio Sixth Month June.** Not unlike the Roland Juno-6 in concept, the SxMJune is a
six-note-polyphonic analog-type synth with one oscillator, one envelope generator, and a basic arpeggiator.

**ElektroStudio Tapeotronic.** The sounds of the Mellotron (a ’60s-era keyboard that played sounds from lengths of analog recording tape) are evoked by the Tapeotronic. Flute, vocal choir, and a string section, all delightfully lo-fi.

**e-phonic Drumatic 3.** An analog-style drum machine that replicates some of the cool sounds from the legendary Roland TR-808. Graphic editing in the VFX Application is highly recommended, as each of the seven drums in the kit has three multi-segment envelopes. (For more information, visit www.e-phonic.com.)

**e-phonic Invader.** A standard two-oscillator virtual analog synth that can produce a range of sci-fi sound effects thanks to its dual modulators.

**e-phonic Solo String.** A physical model of a plucked string, with control over the string length and decay time, plus lowpass and highpass filters in series for a fatter or thinner twang.

**eSLine String Machine.** A digital emulation of the ARP Solina, a ’70s-era analog string machine. Just the thing to go with your lava lamp and bell-bottoms.

**IK Multimedia SampleTank 2 SE.** A good selection of multi-sampled instruments adds to the V-Machine’s sonic palette. SampleTank gives you several basses, brass, woodwinds, drum kits, guitars, pianos, organs, and more. All of the sounds can be filtered and modulated, and effects can be added. (For more information, visit www.ikmultimedia.com.)

**Motion.** If generating hypnotic step sequencer patterns is your thing, Motion (see the graphic editing panel in Figure 3.2) is the synth for you. It has two tone generators – a virtual analog and a phase distortion. These are controlled by separate 16-step sequencers for pitch and filter cutoff, another sequencer that sends gates to the envelope generators, and six separate LFOs for rhythmic modulation. (For more information, visit www.ugoaudio.com.)
Figure 22

Motion has two independent tone generators (top), three 16-step sequencers (left), and six LFOs (right), plus an animated waveform display (lower right).

**SonicProjects OP-X Free.** A virtual analog synth with a nice variety of sounds, but only a couple of basic user-editable parameters. (For more information, visit www.sonicprojects.ch/obx/welcome.html.)

**SuperWave P8.** This virtual analog synth (see Figure 3.3) has a dual-oscillator, dual-filter voicing setup. Essentially, it’s two synthesizers in one. The sound is especially fat because of the seven-voice detuning of the Super Wave oscillators. (For more information, visit www.superwavesynths.co.uk/product_p8.htm.)
Each oscillator in SuperWave P8 has its own filter and envelopes, but they share a pair of LFOs and a pair of delay effects.

**SynthEdit 15 and 15.5.** These virtual analog synths have a mystifying graphic front panel and an equally mystifying voice design, but check out the patches: They sound good.

**SynthEdit Air4th.** As you’ll discover when you try editing this simple but airy-sounding analog-style synth in the VFX Application, the panel controls are labeled in the Cyrillic alphabet. No worries, though: The VFX Application panel and the pop-up tooltips are in English.

**Texture.** Dual filters (but only one oscillator) and a 16-step gate sequencer liven the mix on this monophonic analog-type synth.

**4Front TruePianos.** A very playable sampled grand piano. Other than a switch for the reverb and adjustable velocity response, there are no editable parameters – but there are no editable parameters on a real piano either! Play and enjoy. (For more information, visit www.truepianos.com.)

**4Front Piano, E-Piano, and Bass Modules.** These modules have no editable parameters. The sampled acoustic piano won’t get you to Carnegie Hall, but the E-Piano, sampled from an FM synth with reverb, is very playable. The sampled electric bass has a nice round sound that would work well in a keyboard split onstage. (For more information, visit www.opensound.com/proaudio.html.)
4.2 The Effects
Many of the instruments included in the V-Machine have their own built-in effects (reverb, delay, chorus, and so on). The Moon Sono SX has an audio input, so it can be either a synthesizer or an effect (or both at once). To round out the possibilities, a couple of dedicated effects plugins are included in the V-Machine:

**e-phonic LOFI.** This plugin can do some serious sonic mangling. If you’re editing from the graphic panel within the VFX Application, note that the Amplifier section must be switched on for any of the other sections to process the signal.

**e-phonic RetroDelay.** This stereo delay line is capable of chorus effects, and has its own overdrive and filter. Be careful not to set both the feedback and filter resonance to high levels, as the circuit will self-oscillate, which could blow out a speaker or an eardrum!
5 The VFX Software

The VFX Application is a Windows and MacOS compatible application with which you'll create and configure VFX Library folders for use on the V-Machine hardware.

Although the V-Machine is designed to be used in stand-alone mode, using the pre-installed plugins with which it is shipped from the factory is not really the point. The point is to create your own Presets, Banks, and Libraries using the VFX Application and then load them into the V-Machine in order to play music. The VFX Application is also a great place to start learning about the architecture of the V-Machine’s software signal path.

The V-Machine does not have to be connected to your computer for you to use the VFX Application. You can design and audition Preset sounds in real time using your computer’s built-in sound card or connected audio interface, and any MIDI controller hardware attached to your computer.

As Figure 24 suggests, the VFX Application provides tools with which you can:

- Create VFX Library folders (.vfxlibrary folders) for use on the V-Machine hardware. Libraries can be edited, saved, exported to the V-Machine, and imported from the V-Machine. Libraries that don’t make use of copy-protected plugins can be freely shared with other V-Machine owners.

- Import plugins to the software, so that they can be used in the V-Machine. Later in this chapter you’ll learn exactly how to import plugins.

- Create new Preset sounds, which can use plugin chaining, layering, keyboard mapping, and mixing.

- Audition your Presets.

- Synchronize and/or export VFX Libraries, Banks, and Presets to the V-Machine or external media (USB thumb drives, etc.).

It is important to understand that you can save as many Presets, Banks, and Libraries to your computer's hard drive as you want. Normally you’ll transfer only one library at a time to the V-Machine, but you may want to have separate libraries for different musical situations – one for club gigs and another for recording sessions, for instance.

The basic process for using the VFX Application is visually represented in the diagram shown on the next page.

5.1 Installing the Software

Please install the software before connecting the V-Machine to your computer using the supplied USB cable. If you connect the V-Machine to the computer before installing the software, your computer may fail to identify the V-Machine, or may try to use an incorrect driver with it.

Most of the images used in this chapter are taken from the version of the VFX Application designed to run on the Windows operating system. Although most of the concepts, processes,
and images are identical when running the Mac version of the VFX Application, there are a few differences you should be aware of. Most of these have to do with the installation method, file directory structures, audio interface preference settings, and importing plugins to the software. Macintosh differences will be noted in special sections of this chapter.

Figure 24

Using the VFX Application occurs in several steps, as shown here.

5.1.1 Installing the VFX Application in Windows
The Getting Started CD includes a download program (VFXWebSetup.exe) for the Windows operating system. This program automatically downloads the most up-to-date version of the
VFX Application from the SM Pro Audio website. You must be connected to the Internet for the download to take place.

Steps to install:

- Insert the Getting Started CD into your computer’s CD drive.
- Run the VFXWebSetup.exe download program.
- The program automatically downloads the most up-to-date version of the VFX Application and prompts you for confirmation during the installation process on your computer.
- After installation is complete, the VFX Application is available for use from the Start Menu->All Programs->VFX->VFX. A shortcut will also be created on your desktop.

Note: It is also possible to download the latest version of the VFX Application from the SM Pro Audio website at any time.

5.1.2 Installing the VFX Application in the Macintosh

The Getting Started CD includes a download program (Download VMACHINE for Mac) for the Mac OS X operating system. (This is compatible with Intel-based Macs only.) The program directs your web browser to the SM Pro Audio website, where you can download the most up-to-date version of the VFX Application.

Steps to install:

- Insert the Getting Started CD into your computer’s CD drive.
- Run the ‘Download VMACHINE for Mac’ download program.
- The program directs your web browser to the SM Pro Audio website, where you can download the most up-to-date version of the VFX Application.
- The Mac VFX Application is downloaded in .dmg disk image file format.
- Double-click the .dmg image file to mount the image and follow the installation instructions provided.

Note: It is also possible to download the latest version of the VFX Application from the SM Pro Audio website at any time.

5.2 Differences Between Mac and Windows Operations

Many of the operations of the VFX Application are identical, whether you’re using the Mac or the Windows version. However, there are key differences in a few areas:

1. The Mac OS provides a menu bar across the top of the screen, where the items found in the VFX Application’s own menu are duplicated.

2. VST plugins cannot be installed on the Macintosh before being imported into a Library by the software, so the importing process is a bit more complex in the Mac.

3. The Macintosh VFX Application runs in a Windows emulation layer called X11. When you perform a few operations, such as opening an edit window for a plugin, the window
will open in the X11 layer.

4. If your Mac doesn't have a two-button mouse, you can perform the equivalent of right-clicking by holding the Control key while clicking.

5.3 Quick Overview
When you launch the VFX Application, you’ll see a window that looks much like the one shown in Figure 25. Before we get into specific operations, let’s take a quick look at this window.

![Figure 25](image)
The main window of the VFX Application.

This window has four main work areas – the V-Machine emulator (upper left), the Slots for loading plugins (middle left), the Mixer panel (lower left), and the plugin edit window (right).

At the upper left is an emulation of the V-Machine hardware, complete with four pairs of left/right arrow buttons and a “virtual LCD” display identical to the one on the hardware. The buttons here work almost exactly as they do on the V-Machine. Since it’s not possible to press a pair of left and right arrows at once with the mouse, the emulation also includes a row of clickable buttons across the top. These are labelled MENU, SAVE, LEARN, and so on.

**Important Note:** While these look much like the menu headers in a conventional piece of Windows software, it’s important to understand that they are *not* menu headers. They don’t open drop-down menus. They are command buttons.

Because they don’t look much like buttons, they are sometimes referred to in this manual as *icons*.

Macintosh users will see a conventional menu structure across the top of the computer screen. In Windows, however, the VFX Application has only one menu. This is reached by left-clicking on the VFX icon in the extreme upper left corner of the main window, or by right-clicking anywhere in the window except within a plugin Slot.
To move the main window, click anywhere along its left edge and drag it. The window cannot be resized, but you can minimize it by clicking the short horizontal line in the button bar. The X at the right end of this bar closes the VFX Application.

**Important Note:** The VFX Application will not prompt you to save your edits when you close the program. It will just go ahead and shut down. Before closing the program, please make sure you have saved your edits into the active Library by clicking the SAVE icon, as explained in section 5.6.3. Note, also, that the SAVE icon saves only the current Preset, because only one Preset is active at a time.

The vertical strips in the Mixer area are its channels. Above the Mixer panel are three slots (A, B, and C) for inserting plugins. Each Mixer channel has its own set of three slots and their associated MIDI parameters. To select the slots for a different channel, click on a channel tab below the slots.

When you click on any slot where a plugin has been loaded, the parameters of the plugin will appear in the right-hand area as a numerical list with horizontal sliders. The sliders can be adjusted with the mouse. To open up the graphic editing panel for a plugin, select the plugin by clicking on its slot, and then choose Show VST Editor from the menu. (On the Mac, you can also choose VST Editor in the Window menu.)

More detail on all of these features will be found later in this chapter.

**5.4 Configuring the VFX Application**

In Windows, several of the VFX Application’s settings can be accessed from the VFX Application’s Options dialog box. The Preferences box in the Macintosh version is similar, but simpler. To open the Options/Preferences box, open the VFX Application’s main menu by clicking on the VFX icon in the top left-hand corner of the main window, and choose Options or Preferences, as shown in Figure 26. In the Macintosh, the Preferences box is also available from the VFX menu. The Preferences box is simpler than the Options box because the Mac’s operating system handles MIDI and audio connections automatically.

The Options/Preferences box (see Figure 27) contains settings that provide the VFX Application with details regarding your Preferred and Fallback VFX Library locations (see below). In Windows, the Options box also lets you select your computer’s audio and MIDI interfaces. In the next few sections of this manual, we’ll look at the various features of this box.
5.4.1 Active Library

As you're creating Presets, Banks, and entire Libraries in the VFX Application, the program needs to know where your creations should be stored. Each time you click the SAVE button/icon in the top left command bar, the Preset you're editing is saved to the currently active Library file. Instead of using a Save As... command of the type found in most computer software, to save to a different location you'll open the Options (Windows) or Preferences (Macintosh) box and select a different Library as the Primary library, or create a new Library by entering a new filename in the Select Primary VFX Library file dialog box. This is actually a folder name, not a filename, but you don't need to worry about this, because there's usually little reason for you to open a Library folder and tinker with its contents.

When the VFX Application is installed in Windows, a default VFX Library is created as the following directory: C:\Documents and Settings\[Username]\My Documents\My Music\VFX Library.vflibrary. (Macintosh users will find it created as /Users/[Username]/Music/V-MACHINE Library.vflibrary.) Unless you switch to a different Library, this is where your edits will be stored.

It can be desirable to change the current active working Library for many reasons. For example, you may wish to work directly on a small USB thumb drive Library file rather than working on a Library located on your internal hard drive. Simply change the Primary setting in the top line under Active Library in the Options/Preferences box, and the VFX Application will use the specified drive and Library.

The VFX Application’s Options/Preferences box offers the choice of Primary and Fallback Libraries. The Fallback Library option tells the VFX Application which Library to use when the
main Library is unavailable. For example, if you disconnect the thumb drive that stores the active Library, the VFX Application will revert back to the Fallback Library setting. If you're in the middle of an editing session when you disconnect the drive containing the Primary Library, your next Save operation will be directed to the Fallback Library instead. To prevent confusion in file management, it is recommended that you not disconnect a drive containing the Primary Library while you're editing Presets in the VFX Application.

**Important Note:** If the VFX Application is using the Fallback Library (because the designated Primary Library is currently not available), when you plug in the drive containing the Primary Library, any edits that you have made in the current preset may be lost when the VFX Application automatically switches to the Primary Library. For this reason, it’s a good idea to get in the habit of not attaching or removing drives containing Libraries while the VFX Application is running.

The text beside the word Current (which is read-only, not editable) shows the currently active Library that is being used by the VFX Application. To change to a different Library (or create a Library in a different drive location), click the Browse button (in Windows, it shows three dots; in the Macintosh, you’ll see the word “Browse...”) at the right end of the Primary field. You can also type the location of a Library directly in the Active Library text field.

### 5.4.2 Audio System

In Windows only, you’ll need to select the Audio System driver model and Audio Device Playback and Capture (input) devices you would like the VFX Application to use. For the best possible performance we recommend selecting the ASIO driver model if it is supported by your hardware. If you’re using ASIO, the input device will always be the same as the output device, so the dropdown Capture menu will always be grayed out. If you need a more flexible audio routing, we recommend the Asio4All driver, which is freeware, available for download from www.asio4all.com. If you choose the DirectX audio output, you will not be able to use an audio input in the software.

In Windows, click on the Configure button to open your audio interface's control panel. Your computer’s audio interface control panel may offer settings such as buffer size, in addition to its own mixer. Please refer to your audio interface operation manual for details.

In the MacOS, the audio in device must normally be the same as the audio output device. However, you can make a composite audio device if you need to, using the Mac's aggregate device editor. (For details, see www.apple.com/pro/techniques/aggregateaudio/.)

### 5.4.3 MIDI System

In the MIDI-IN box within the Options box, click on the checkboxes corresponding to any MIDI input devices that you use. The MIDI input will enable you to play Presets in the VFX Application so as to be able to check your edits. Normally you will want the V-Machine itself to be checked in the MIDI-IN and MIDI-OUT boxes, so that the VFX Application can communicate with the V-Machine.

There is no provision to send MIDI data out of the VFX Application other than to a connected hardware V-Machine over USB, so there’s no need to click the checkbox next to any other MIDI interface in the MIDI-OUT area.

Mac users will not need to select MIDI in and out devices, as these choices will be handled automatically by the MacOS.
5.5 Importing Plugins to the Active VFX Library

5.5.1 Important Preparation & Concepts
Before you start building Presets for the V-Machine, it’s important to understand a few key concepts.

When you import a plugin into the VFX Application, several things happen. First, the software code of the .dll itself (the code that allows the plugin to run) is copied into the active Library’s folder on your hard drive. For this reason, before importing plugins, you should check in the Options/Preferences box to make sure that the currently active Library is the one you want to import the plugin into. Any sample libraries required by the plugin are also copied into the active Library. With large sample libraries, this process can take a few minutes.

If the plugin is copy-protected, after the files are copied, the VFX Application will attempt to authorize the plugin to operate on the V-Machine. Because of this, the V-Machine will need to be connected to the computer. The details of how authorization is handled are discussed in section 5.5.5 on page 60. We recommend that Windows users always install plugins on their computer according to the plugin developer’s installation instructions before importing the plugin to a VFX Library. Typically this will mean using a setup program provided by the plugin developer. This process ensures everything required by the plugin is correctly installed and is able to be played/auditioned when the plugin is imported to the VFX Application.

Note: Some plugins do not have an installation process. If a plugin is downloaded as a .dll file rather than as an .exe, it does not have an installer; the way to use it in a Windows computer is simply to drag the .dll into your VSTplugins folder (wherever that happens to be). Plugins that lack installers can be imported into the current Library directly and may not have to be installed on the PC prior to import. This is often true of freeware plugins. After downloading such a plugin, you can use the VFX Application’s import command to direct the VFX Application to the .dll file, even if it’s still in the folder to which you downloaded it. You can download a freeware .dll to a Macintosh and then import it into the VFX Application in the same way.

It is also possible to import a plugin to the active VFX Library by importing or merging Banks, Presets, and associated plugins from another VFX Library (possibly a VFX Library your friend set up and gave to you on thumb drive). To do this, use the Import from VFX Library command in the File area of the main menu. When you do it, there are a few benefits and limitations you should be aware of.

Benefits

- Importing this way allows the use of plugins that you have previously installed on the PC as per the developer’s instructions and imported to the VFX Application to appear more quickly in your new Library.

- You can combine portions of your existing Libraries at will. For example, you can import a favorite Bank from one Library to another.

Limitations

- If you import a Bank, Preset, and associated plugin from another VFX Library to your active Library without the plugin’s having been previously installed to your PC as per the developer’s instructions at an earlier stage, you may not be able to audition the plugin via the VFX Application.
• If you import copy-protected plugins from a Library that was authorized using a different physical V-Machine, they will fail to run on your V-Machine.

### 5.5.2 Installing Windows Plugins in the Macintosh

It’s important to understand that when you install a Windows-based plugin in your Macintosh using the VFX Application, the plugin will be usable only by the V-Machine and within the VFX Application itself. Such plugins cannot be used by other Macintosh-based host software. Conversely, you will not be able to import a Macintosh-formatted VST plugin into the VFX Application, unless you have an installation CD for the plugin that contains both the Macintosh and Windows versions.

From the VFX Application’s File menu on the Mac, select Run VST Plugin Installer. Choose the installer program (probably a .exe file) that you have downloaded, or that is resident on a CD or DVD. If the CD or DVD you have inserted is a hybrid Windows/Mac disk, the VFX Application will be able to find the Windows partition on the disk. The installer will run in the X11 environment. The software should be installed in Users/[Username]/Music/VFX Wine VM.vfxwinevm/drive_c/Program Files.

When the installer has finished running, return to the VFX Application and choose Import VST Plugin from the File menu. Then use the steps in the next section (below).

### 5.5.3 Plugin Installation Utility

The VFX Application includes a Plugin Installation Utility, which is designed to assist in importing plugins for use within the active VFX Library. Each time you create a new Library, you will need to re-import all of the plugins you intend to use in that Library. While this is a bit time-consuming, it insures that each Library that you create contains only the plugins that are needed for that Library.

**Note:** If a plugin is no longer needed in a given Library, you may want to remove it from the Library. This is an especially good idea if you’re using a USB memory stick with a small storage capacity. The VFX Application itself has no obvious command for removing plugins from the Library, but you can do it using the V-Machine emulation panel in the upper left corner. Click the MENU button, which activates the virtual V-Machine’s Global System Settings menu in the virtual LCD. Then click on the right arrow button in the top row until you see the line “Menu: Delete Plugins.” Choose the plugin you want to delete using the arrows in the second row, and then click the left arrow in the third row, by the word Delete. This will remove the selected plugin from the Library.

Selecting the Import VST Plugin option from the VFX Application’s main menu (or from the VFX Application’s File menu in the MacOS) initiates the Plugin Installation Utility. You can also invoke the Installation Utility by clicking on the orange triangle at the right end of a slot in the VFX Application’s mixer, as this same menu option appears there. The Utility prompts for user feedback/confirmation during a step-by-step installation process. When you run the Utility, the plugin’s .dll file is copied to the current VFX Library folder along with any supporting files (samples, etc.).

The Plugin Installation Utility expects to find plugins installed to their default locations. If for some reason you have installed a plugin to a different folder, the Utility may have trouble loading it. If the Utility can’t find the plugin, you can try copying the .dll file temporarily to a default VstPlugins folder (the one the Installation Utility is trying to look in). This method may cause other problems, however, such as causing an authorized plugin to run in demo mode.
You should attempt it only as a last resort.

Figure 28

Accessing the Import VST Plugin box from the main menu.

Figure 29

The Import VST Plugin dialog box.

Steps to import a plugin to the active VFX Library:

- Select "File -> Import VST Plugin" from the VFX Application menu, or by clicking on the orange triangle in a Slot.
- The VFX Application will open the installation dialog window and prompt you to select a VST plugin to import.
- Use the drop-down menu to display a list of VST plugins that have previously been installed on your PC. If you are importing a VST plugin from another location (such as from your Downloads folder) you can select the “<Browse...>” item to open a standard file browser.
- Once you have made your selection, proceed to select the associated VFX Wizard File (read more about Wizard Files below). If no Wizard File is available, choose “<Don’t use
a Wizard File>" from the Wizard File drop-down menu.

- Click the Import button.
- After the plugin is imported, you may be prompted to take further steps in order to authorize it for use on the V-Machine. For details on how the authorization process works, see section 5.5.5 on page 60

If the plugin you are attempting to import is known to the current VFX Application database, it will appear automatically in the Wizard File selection menu. If the plugin you are attempting to import is not included in the database, you can check for Wizard File updates on the Internet by clicking the "Check for Wizard Updates" button. The Wizard database is updated often, adding support for more and more plugins over time. To learn which plugins currently have Wizard Files, you can consult the SM Pro Audio website here:


If a Wizard File is not available, there are several options:

- Attempt to import the plugin without a Wizard File by choosing "<Don't use a Wizard File>" in the Wizard File drop-down menu. Some plugins may work without a Wizard File.
- Attempt to write your own custom Wizard File. This is not a simple process. The file itself is a plain text file, so it can be created in any text editor program, but the codes in the file have special meanings.
- Find an appropriate custom Wizard File by checking with other users on Internet forums.

If none of the above methods is successful, you won't be able to import the plugin.

5.5.4 More About Wizard Files (Plugin Information File “.vfxwizard”)

Some plugins can be installed on your computer and successfully synchronized to the V-Machine without the need for a Plugin Information Wizard File (.vfxwizard). However, other plug-ins may have additional files, folders, and Windows Registry settings that are required to ensure successful operation.

A Plugin Wizard File is a text file that describes all additional information required by a plugin to import and operate on the VXF Application and V-Machine hardware. Wizard Files provide compatibility for plugins that otherwise would not function on a standalone host. Wizard Files are needed by the V-Machine to load plugins and associated files, samples, Registry entries, and other requirements when a plugin is used outside of Windows.

Wizard Files are more important for allowing the V-Machine hardware to operate successfully after synchronization or the exporting of a Library than for the VFX Application operation itself. This is because Windows applications like the VFX Application know how to handle the plugin if it was originally installed to the system with its own installation program.

A database of commonly requested Plugin Wizard Files is maintained in the SM Pro Audio website for users to download. The list of available Wizard Files is growing rapidly. Please check the website:

for updates. Keep in mind that although the plugin may import and function within the VFX Application, it may not synchronize/export and function correctly (or at all) in the V-Machine without an accompanying Wizard File.

5.5.5 Plugin Authorization

If a plugin is copy-protected and therefore requires authorization in order to run, you should install it and authorize it on your PC as per the original manufacturer's instructions, before importing it into the VFX Application in order to add it to a Library. This makes it much easier to import and synchronize or export to external media successfully for use on the V-Machine. However, you will very likely need to authorize it separately for use in the V-Machine. If the manufacturer of your plugin provides only a limited number of authorizations, and if you have already used all of them (for instance, because you use the plugin both on a desktop computer and on a laptop), you may need to request an additional authorization from the plugin manufacturer in order to authorize it on the V-Machine. Most manufacturers will be happy to provide an additional authorization on request.

Commercial plugins often require a mechanism for authorization. The V-Machine offers support for various methods to assist with compatibility. Before attempting to import a plugin that requires authorization, connect your V-Machine to the computer. The authorization process will usually require some data that the VFX Application will download from the V-Machine.

If you have already imported a plugin into the VFX Application before connecting the V-Machine, you can start the authorization process from the main menu. After making sure that the plugin you want to license is the currently active plugin (click on it in the Mixer slot so that its parameter list or graphic editing panel appears), select Plugin > License Plugin for V-MACHINE. This will initiate the process. What happens next will depend on the authorization method provided by the plugin manufacturer. For example, you may see a dialog box in which you will need to enter a serial number.

**Serial number authorized plugin:** Many plugins ask users to enter a serial number before using the plugin for the first time. The serial number is often then stored in the Windows Registry or to a particular key-file stored on the local system. The plugin checks for the serial number during loading to ensure you have a license to use the software.

As long as the V-Machine is plugged into the computer during the authorization process, the necessary information will be stored in the V-Machine and in the current Library in your computer. You shouldn’t need to worry about the details of what data is stored where. If you encounter problems during authorization, contact SM Pro Audio at [http://smproaudio.helpserve.com/index.php](http://smproaudio.helpserve.com/index.php) for help in troubleshooting the problem.

**Challenge response (hardware profiling):** Some plugins perform a hardware profile of the PC you wish to authorize to during installation, and create a special code that allows the software to run only on that machine.

SM Pro Audio provides third-party plugin developers a mechanism whereby the VFX Application can run developers’ profiling applications directly on the V-Machine (via USB) and respond to the results as required. Many vendors using challenge response are working with us to include their profiling tools into the VFX Application. Check the SM Pro Audio website to learn whether the manufacturer of your plugin(s) is doing this.
If the plugin uses challenge response authorization, connect the V-Machine to your computer and turn it on before launching the VFX Application. On importing the plugin into the VFX Application, you will see a dialog box. This box may ask you to enter the serial number of the plugin. It may then provide a challenge code. Copy this code, go to the plugin manufacturer's website, and get the response code. Then return to the VFX Application and enter the response when prompted to do so in the dialog box.

*Hardware USB key dongle protection:* Pace iLok and Syncrosoft eLicenser USB protection key support is not yet available with the V-Machine, but is currently under investigation by the development team. Please check the SM Pro Audio website for updated information on this feature.

### 5.5.6 Installing Plugins on the V-Machine Without the VFX Application

When possible, you should always use the VFX Application to prepare your plugins by loading them into Presets in a Library. However, the V-Machine may be able to recognize and play certain raw VST .dll files when they’re stored directly on a USB memory device without use of the VFX Application. This method will not work with all plugins, because many plugins, especially those from commercial developers, have more complex installation requirements.

The V-Machine can recognize plugins on connected USB drives and memory sticks when they are presented in the following format:

```
Flash/USB Drive -> "plugs" (directory) -> "plugin name" (directory) -> "plugin.dll" file
```

The plugs directory must be in the root directory of the USB memory device. If you use this method, the plugin will appear in the final Bank on the V-Machine, a default Bank called Plugin Parade.

**Example:** Procedure for using a freeware plugin named plug1.dll without importing it into the VFX Application:

- Create a folder and name it “plugs”.
- Create a folder inside “plugs” and name it “Plug1”.
- Copy the plugin file “Plug1.dll” to the folder “Plug1”.
- Copy the folder “plugs” onto a USB memory stick, in the root directory.
- Turn on the V-Machine if it isn’t already on.
- Insert the USB memory stick into the V-Machine.
- Scroll to the right end of the Banks menu in the V-Machine’s LCD. You should now find the plug-in named plug1.dll.
- Press the Load button.

The Plugin Parade Bank contains a default preset. The selected plugin will be loaded into Slot A of Mixer channel 1. If the plugin is an instrument, it will receive in MIDI omni mode (on all channels).
5.5.7 VFX Application Main Menu

The VFX Application main menu can be opened by clicking on the VFX icon in the top left corner of the V-Machine Pane, or by right-clicking anywhere in the VFX Application’s window except in a Slot. The Macintosh software has the same main menu, but it also has a Mac-style menu bar across the top of the screen, where many of the menu items are duplicated.

The main menu has a selection of options, including:

- File (see below).
- Bank (see below). The Bank menu commands are also available by clicking on the Bank name in the V-Machine panel in the software.
- Preset (see below). The Preset menu commands are also available by clicking on the Preset name in the V-Machine panel in the software.
- Plugin (see below).
- V-MACHINE (see below).
- Show VST Editor. This menu item (see Figure 30) opens the graphic front panel of the currently selected plugin. To select a plugin, click on the slot that contains it.
- Options/Preferences... The functions of the Options/Preferences box are explained in section 5.4.
- Help... This menu item opens a link to the Help section of the SM Pro Audio website.
- About VFX... This menu item opens a dialog box where you can read the version number of the software.
- Exit/Quit VFX.

5.5.7.1 File Menu

The Save Preset command duplicates the function of the SAVE icon in the command bar. It saves the current Preset to the currently active Library.

Use the Import from VFX Library... menu item to import all Banks, a specific Bank, or a specific Preset from the chosen Library into the current Library. After you choose a Library folder using the computer’s file dialog box, a window will open up showing the contents of the Library you have chosen. Using a checkbox in the window, you can choose to import with or without the associated plugins.

It may sometimes happen that you want to import a Preset or Bank into a Library that contains some, but not all, of the same plugins. If you highlight the radio button next to “Keep existing plugins,” then any duplicated plugins in the Library that you’re importing into will be kept as is.
If you highlight “Replace existing plugins,” then in the case of a duplicated plugin, the one in the current Library will be replaced by one from the other Library.

When you choose Export to VFX Library..., you will see a box showing the contents of the currently active Library. Choose the item (All Banks, a single Bank, or a single Preset) that you want to export, and use the checkbox and radio buttons to specify how you want to handle the plugins during the export operation. As with the importing dialog box, if you choose “Keep existing plugins” when exporting, then any duplicated plugins in the Library to which you’re exporting will not be changed. If you choose “Replace existing plugins,” then any duplicated plugins in the other Library will be replaced. After you choose an item, click the Export button. A file dialog box will open, in which you will be asked to choose the Library folder that the item will be exported (copied) to. Note that exporting an item does not remove it from the currently active Library.

With the Import VST Plugin... item in the File menu, you can import a plugin into the currently active Library. The details on this procedure are found in section 5.5 on page 56.

5.5.7.2 Bank Menu

Each Library can contain one or more Banks. Creating Banks of related Presets will make the Presets easier to find and load quickly on the V-Machine. To create a new Bank, use the New Bank command in the Bank menu. This will create a Bank with a default numbered name (such as “Bank 1”). You can then use the Rename Bank... command to give this Bank a useful descriptive name.

The command Delete all Presets in Bank clears a bank. When you choose this command, you’ll see a dialog box asking you to confirm that this is what you want to do. The Delete Bank command is similar, but it deletes both the Presets in the Bank and the Bank itself. The Delete All Banks command clears the Library of all Banks. These commands do not, however, remove plugins from the Library. To remove plugins, use the commands in the Plugins menu.

**Important Note:** There is no undo command in the VFX Application. Don’t delete objects unless you’re sure you won’t need them again (or unless they’re safely backed up in some other Library).

5.5.7.3 Preset Menu

The functions of the Clear Preset and Rename Preset commands should be self-explanatory.

When you choose Clone Preset From, you’ll see a submenu showing the Presets in all of the Banks in the current Library. Choose the Preset you would like to use as the source for the clone operation. It will be copied into the current Preset. This operation will overwrite the data in the current Preset. However, any plugins that may have been used in the current Preset will still be available; they won’t be deleted.

You’ll note that there is no New Preset command. To start working on a new Preset, click the right arrow button in the second row of the virtual V-Machine’s display pane. Click it one or more times, until you reach a new, empty Preset, then start adding plugins to the preset. (Be sure to save it after creating it.)

5.5.7.4 Plugin Menu

The License Plugin for V-MACHINE... command is located in the Plugin menu. If the currently selected plugin (the one whose parameters are visible in the right side of the VFX Application
window) is not yet licensed, this command will initiate the licensing/authorization procedure as discussed in section 5.5.5. If the plugin is already licensed, the VFX Application will alert you to this fact, and ask if you would like to re-license it. Unless you have some specific reason for re-licensing, you should avoid doing this, as it will probably use up one of a limited number of authorizations provided by the plugin’s manufacturer.

5.5.7.5 V-Machine Menu

The Sync... command in the V-Machine menu duplicates the function of the SYNC icon in the command bar, as explained in section 5.6.6 on page 66.

The command to Update V-Machine firmware can be used to check whether your V-Machine’s operating system is up to date. Normally, this process will happen automatically if you connect a V-Machine whose software is outdated. If the V-Machine needs to be updated, consult the steps in section 3.9 on page 40.

5.6 V-Machine Pane

The V-Machine Pane (see Figure 31) is a virtual representation of the real V-Machine’s front panel. Clicking on any of the eight keypad buttons does the same thing it would on the real hardware version. This gives you an easy way to configure and test your Presets.

You can use the V-Machine Pane to navigate the Banks and Presets in the currently active Library, adjust parameter values, assign external MIDI controllers, and enter Global System Settings. If the Library you're editing contains multiple Banks, for instance, or if a Bank contains multiple Presets, you’ll step through the Banks and Presets using the buttons in the V-Machine Pane exactly as you would on the hardware unit. The strip along the top contains the four dual-button-press commands available on the V-Machine hardware (MENU, SAVE, LEARN, and PANIC), plus two buttons (SYNC and HELP) whose usage is explained later in this chapter.

In this manual, the words MENU, SAVE, LEARN, and so on are referred to as “icons,” even though they aren’t graphic icons in the traditional sense. They function like buttons, though they don't look like buttons either. They may look like menu headers, but they’re not.

![Diagram of V-Machine Pane](image)

**Figure 31**

The V-Machine pane in the VFX Application. The words in the top row duplicate the dual-button-press functions of the V-Machine.

5.6.1 Standard Keypad Browsing

The keypads on the V-Machine Pane respond exactly like those on the hardware unit. Browse
left and right through the Banks and Presets in the currently active Library by clicking the left and right arrow buttons.

Parameter values can also be adjusted here, and the results will be updated immediately in the Parameter Pane view (either in the graphic panel for the plugin or in the list of parameters). It will usually be easier to use the latter, however.

As in the hardware unit, if the lower left corner of the display shows the words Load and Back, the other buttons will be inactive. You will need to click the left arrow next to one of these words in order to proceed.

**Important Note:** If you use the left or right arrow on the Bank or Preset line to select a different Bank or Preset, and then click the left arrow by Load, the active Preset will be replaced by the new one. If you have made changes in the active Preset before giving the command to load a new one, *you will not see an "Are You Sure?" message.* The VFX Application simply assumes that you have saved your work before loading a new Preset, or else that you are choosing to abandon your edits. There is no undo command, so be careful about clicking the Load button.

### 5.6.2 V-Machine Global System Settings Menu Icon

Clicking the MENU icon in the top strip allows you to navigate the Global System Settings. These operate almost exactly as on the V-Machine hardware except that the buffer size of a Preset can’t be adjusted. This is because the audio buffer settings used by the VFX Application are controlled by your computer’s audio interface. And while you can adjust the LCD display contrast, your adjustments will have no effect.

The Global System Settings you set here will be saved and transferred to the V-Machine during the synchronization process via USB or the Export process, as detailed in section 5.6.1. The Export command in the Global System Settings area duplicates the Export to VFX Library... function in the software’s File menu. Likewise, the Import command here duplicates the Import from VFX Library... command in the File menu.

To exit the Global System Settings, press the keypad button adjacent to the word “Back,” which will be displayed on the on-screen LCD panel.

### 5.6.3 Save Icon

Clicking the SAVE icon activates the Save command.

Just as on the V-Machine, the Save command saves the current state of the currently selected Preset, storing it in the currently active Library. You will see a brief confirmation message in the upper left pane while the save action is occurring.

### 5.6.4 Learn Icon

Clicking the LEARN icon activates the Learn command.

The Learn command is used for assigning plugin parameters to external MIDI control-change messages. This is a great way to have hands-on control of your V-Machine during performances.

This function operates the same way as on the hardware V-Machine:

- Make sure you have the plugin parameter that you want to assign to a MIDI message selected in the third row of the virtual V-Machine panel.
● Click the LEARN icon to activate the Learn command.

● Move the controller knob/fader on your connected MIDI controller.

The plugin parameter has now been assigned to receive MIDI control messages from your chosen controller. If you want to remove an active MIDI routing, choose the parameter that is being controlled via MIDI, click the LEARN icon, and then click the arrow next to the word "Unlearn."

**5.6.5 Panic Icon**

Mouse clicking the PANIC icon activates the MIDI Panic command.

The MIDI Panic command sends an all-notes-off MIDI command to the plugins in the current Preset. This may be necessary to eliminate troublesome stuck MIDI notes, as can occasionally happen with various combinations of MIDI controllers and VSTi plugins.

**5.6.6 Sync Icon**

Clicking the SYNC icon initiates one of two processes. If you have a V-Machine connected to your computer and turned on, the V-Machine’s memory will be synchronized with the VFX Application’s active Library. If no V-Machine is detected, clicking the SYNC icon activates the Export process instead.

Exporting is faster than synchronizing if you need to load a plugin and its associated files into the V-Machine. However, if all of the required plugins are already resident in the V-Machine, synchronizing is fast — just uncheck the With Plugins box in the Sync dialog box.

Synchronizing with plugins requires that the entire contents of a Preset, Bank, or Library be sent to the V-Machine over USB using the MIDI system-exclusive data protocol. This type of data transmission can be quite slow with large plugins, especially those that include samples.

A dialog box will open and show a tree structure outlining the contents of the current Library.

You can choose whatever object(s) you would like to send to the V-Machine. They will be stored in the V-Machine’s internal Flash memory, and can then be loaded into the V-Machine’s RAM to be played.

Before the Sync process starts, you’ll see another dialog box, which gives an estimate of the amount of time required and asks if you’d like to export instead. Depending on various factors, this estimate may not be entirely accurate. To proceed with synchronization, click the Sync button in this box.

If you choose to export instead of syncing, a file dialog box will open. Choose a location for the exported Library.

**5.6.7 Help Icon**

Clicking the HELP icon opens the V-Machine FAQ page on the SM Pro Audio website.

**5.7 Plugin Pane**

The Plugin Pane (see Figure 4.9) has 21 slots in which you can insert and configure plugins for use in your Presets. A single Preset can make use of up to 21 plugins. At any given time, one of the plugins will be active for editing. You’ll see the parameter list of the currently active plugin, or its graphic front panel if you have used the Show VST Editor command in the menu (see Figure 30). To make a plugin active, click on its slot. (Note that this use of the word “active” doesn’t refer to the question of whether the plugin can create or process audio. Many plugins
can be active for audio purposes, but only one of them will be active for editing.)

A set of seven tabs below the slots offers quick access to each of the main areas of the Mixer's signal path. Select the appropriate channel (1 through 4), effects bus (1 or 2), or the Main tab to view the corresponding plugin slots.

The V-Machine's architecture allows for three plugins to be inserted into each section of the mixer. Each of the four mixer channels, two FX returns, and the Main output channel can be loaded with up to three plugins.

You will likely run out of CPU horsepower on the V-Machine before you fill all 21 slots. Depending on the speed of your computer, you may be able to load more plugins into a Preset in the VFX Application than can run in the V-Machine itself, but you'll certainly run out of computing power in the V-Machine if you try to run 21 plugins at once.

![Plugin Slot Name Display](image)
![Popup Plugin Selector](image)
![MIDI Channel Selector](image)

**Figure 32**
**Figure 4.9:** The plugin pane.

To get the best performance from your V-Machine, you'll need to think about how to make the best use of the plugins. For instance, if two instrument plugins both need reverb, it's more efficient to put a single reverb plugin on one of the Mixer's send channels rather than putting a separate reverb in the B or C Slot below each instrument. The number of plugins you can run will also depend on how many notes you ask each plugin synthesizer to play simultaneously, and on how complex or efficient the plugin's voice is. The only way to determine how many plugins you'll be able to run in a V-Machine Preset is through experimenting.

### 5.7.1 Channel Plugin Slot

Each Mixer channel features three slots (A, B, and C) into which plugins can be inserted. The plugin slot name display area shows the name of the currently loaded plugin.
Individual plugin slots provide a plugin name display area, a MIDI channel selector, and a MIDI key range split box.

Quick Tip: Clicking your mouse in the plugin slot name display area will switch the Parameter Pane to show that plugin’s VST GUI or parameter list (depending on your View setting). You can then tweak that plugin’s parameters in the Parameter Pane.

Audio is routed downward through each of the three plugin slots in order. The output of slot A in a given channel is routed to the input of slot B, and the output of slot B to the input of slot C. The output of slot C is then sent to the Mixer.

VST instrument plugins should only be loaded into the first Plugin Slot (Plugin Slot A) of each Mixer channel. This is because most instruments do not have audio inputs. If you load an instrument into slot 1 of a channel and another instrument into slot 2, you will usually hear only the instrument in slot 2, because the output of slot 1 will have nowhere to go. If the instrument in slot 2 happens to have active audio inputs, which can happen if it is also usable as an effect, then you’ll hear both instruments at once. However, you won’t have separate mixer control over them. For this reason, it’s best to put instruments only into the A slot of each mixer channel, and to reserve slots B and C for effects processors.

5.7.2 Pop-Up Plugin Selector
Clicking your mouse on the Pop-Up Plugin Selector (the downward-pointing orange arrow) displays a list of plugins that have been previously installed into the active Library for use by the VFX Application.

Select the desired plugin from the list to load it into the corresponding Plugin Slot. To remove a plugin from the Plugin Slot, select ‘None’ from the Popup Plugin Selector menu. To add a plugin to the Library, choose ‘Import VST Plugin...’ from this menu. This command duplicates the same command in the File menu. For details on how to import a plugin, see section 5.5 on page 56.

5.7.3 Plugin MIDI Channel Selector
By clicking your mouse on the MIDI Channel Selector adjacent to a Plugin Slot, you can assign the MIDI channel you would like the plugin to respond to. MIDI channels 1-16 and an ALL MIDI channel option are available. To create a keyboard layer, for example, you would put two or more plugins in slot A of separate Mixer channels and leave the MIDI Channel Selector of each slot set to ALL. When you do this, playing a single note on a MIDI keyboard will trigger all of the plugin instruments, because the MIDI input of the V-Machine is routed to all of the Mixer channels. For multitimbral operation, in which your keyboard has several zones each of which is transmitting on its own MIDI channel, insert plugin instruments into Mixer channels as required, and then assign each instrument slot to a MIDI channel that corresponds to the keyboard zone from which you want to play that plugin.

Below the channel fields in the pop-up menu is a switchable setting for MIDI-IN from Computer. Normally you will want this to be switched on for slot A, so that the instrument in slot A can receive notes. However, you may want to uncheck it for slots B and C to prevent controller messages from being passed on to effects processors in those slots, as the effects might respond to the controller messages in ways that you don’t expect.

MIDI messages can be passed from slot A to slot B and from slot B to slot C if desired, using settings in this pop-up menu. You might want to use these settings, for example, if the plugin in slot A has an arpeggiator that can transmit MIDI notes, and you want a step filter in slot B to
respond to the arpeggiator pattern. In order for the “MIDI-IN from Slot A” item to work with the plugin in slot B, there must be a plugin in slot A. If for some reason you don’t want to put a plugin in slot A, then slot B should be set to “MIDI-IN from Computer” instead.

5.7.4 Plugin Slot Split Selector
The Plugin Slot Split Selector box lets you assign high and low limits for the MIDI note range that the plugin in that slot will respond to. The main usage of this setting is for creating keyboard splits when your MIDI keyboard itself is transmitting on only one MIDI channel. To assign up to four plugin instruments to separate zones of your master MIDI keyboard, put one instrument in slot A of each Mixer channel. Then set the upper data field to the top note of the desired keyboard range, and the lower data field to the bottom note of the range.

For example, consider loading a bass plugin into Plugin Slot A on Mixer channel 1 and a piano plugin into Plugin Slot A on Mixer channel 2. Assign both slots to the same MIDI channel (or leave them set to ALL). Then configure the high and low MIDI note settings of each of the plugins, making sure the ranges do not overlap. This is a simple way to create a split keyboard layout.

If the SPLIT box settings are left blank, the plugin will respond to the full range of MIDI notes.

To edit the SPLIT values, click and hold and drag your mouse up or down.

5.7.5 Mixer Channel, FX Send, and Main Output Selector Tabs
Selector tabs offer an intuitive way to access any of the 21 plugin slots. Clicking on any of the tabs will update the Plugin Pane to show the corresponding set of slots.

The selector tabs are clearly labelled. The active tab extends upward into the slot area, showing which channel’s plugin slots are currently displayed.

When you select a different tab, the Parameter Pane will update to display the parameters of the plugin residing in slot A of the corresponding tab.

5.8 Mixer Pane
The Mixer Pane provides an interface for configuring the Mixer settings. A simple channel strip layout provides visual feedback of channel Gain, Pan, and Send values. Typical mixer functions like input select, mute, and solo are also accessed from the Mixer Pane. The four main channel strips are on the left, followed by the two FX buses. The master output channel is on the right.
Double-clicking on a Mixer channel's fader or pan controls will return it to its default setting.

5.8.1 Channel Gain
Channel output gain controls are available for the four mixer channels, two FX bus returns, and the stereo Master output channel.

Click and hold your mouse button over the channel Gain control area and move up or down to adjust the corresponding channel gain value. Release your mouse button when you have made the desired adjustment. When the channel is set to unity gain (no cut or boost), the small indicator lights beside the gain slider will glow.

5.8.2 Channel Pan
The channel Pan knob allows you to place the sound source in the stereo field. Adjustments can be made from extreme left to extreme right.

Click and hold your mouse button over the Pan icon and move up or down to adjust the Pan value from left to right. Release your mouse button when you have made the desired adjustment. When the pan position is centered, the segments at the extreme left and right ends of the curve will also light.

5.8.3 Channel Mute
The channel Mute button (which appears in the pane as the letter M) places the corresponding mixer channel into Mute mode. The Mute mode allows you to mute to one channel at a time while you listen to and adjust others.

Click your mouse on a channel’s Mute icon to toggle the corresponding channel’s Mute function ON and OFF. When the Mute button is active, it glows more brightly.

5.8.4 Channel Solo
The channel Solo button (the letter S) places the corresponding mixer channel into Solo mode. The Solo mode allows you to single out a sound to make fine adjustments.

Click your mouse on a channel’s Solo button to toggle the corresponding channel’s Solo
function ON and OFF. When the Solo button is active, it glows more brightly.

**5.8.5 Toggle Mode**

In the V-Machine Pane, as on the V-Machine’s LCD itself, you will see two Mute and two Solo parameters – Mute, Mute(T), Solo, and Solo(T). The Toggle modes have no visible representation in the Mixer Pane itself, as they relate strictly to control of the Mixer’s Mute and Solo switches from an external MIDI controller.

**5.8.6 FX Sends 1 & 2**

The FX send 1 & 2 send knobs in the four main channels route the audio signal to the FX1 & FX2 effects bus slots. The signal from these slots is then returned to the mix via the FX1 and FX2 return channels. Each FX bus features three plugin slots, just like the other mixer channels.

Click and hold your mouse button down over the FX send knobs in the four channels and move up or down to adjust the send value for the channel.

FX sends can be configured as either pre- or post-fader. By default, each send is configured as post-fader. Right-clicking on a send knob (Control-clicking on the Mac) will display the Pre/Post menu. Select either Pre or Post as desired.

A pre-fader output is independent of the level of the channel fader, and of the channel’s Mute button. The FX send output gain stays at the same level no matter how the channel gain fader is set.

A post-fader output depends on the current channel gain fader level. Turning the channel fader down results in a reduced FX send output signal.

*Quick Tip:* FX sends are a great way to share VST plugin effects between channels and thus minimize the impact on the CPU. For example, this would be beneficial if you needed a similar reverb effect across a multi-channel Preset. By using one reverb plugin in the FX send channel rather than two or three in individual channel Slots, you reduce the DSP load on the CPU.

**5.8.7 L&R Audio Input Selector (CAPS)**

The left and right audio input selectors can be enabled to feed external audio source material into Mixer channels for further processing.

Click your mouse on a channel’s L or R audio input selector icon to toggle the corresponding channel’s Left or Right audio input on or off. When the input is on (active), the input indicator glows more brightly.

In the VFX Application, the corresponding channel will receive audio signals from the inputs of the audio interface specified in the Options box (Windows) or in the Sound Input section of the System Preferences (Macintosh).

After you have saved your Preset and exported or synchronized it to the V-Machine, when the Preset is active in the V-Machine audio signals received at the V-Machine’s rear panel audio input will be sent to any mixer channel in the current Preset whose input(s) are active.

*Note:* The USB connection between the V-Machine and the computer does not transmit audio data. As a result, signals patched into the rear-panel audio input of the V-Machine cannot be processed by a Preset while the Preset is running in the VFX Application software.

*Quick Tip:* Unless you’re using the Preset to process external audio, make sure the audio inputs
for all channels are disabled.

5.8.8 FX1 & FX2 Channels
The FX1 and FX2 return channels are provided to return signal to the Mixer that you have sent through the FX bus plugin slots. The Mute, Solo, gain, and pan controls on these channels function like those on the other channels.

Note that you can insert VST instruments into the FX1 and FX2 channels if desired. These channels receive MIDI inputs, and can be used for additional layering of instruments. However, if you configure a Preset in this manner, you will no longer be able to use the FX channel as a send.

5.8.9 Main Stereo Output Channel
A Main channel gain control is available for adjusting the master volume of the configured Preset.

The Main channel is the last stage in the audio routing structure. It outputs the sum of the mixed audio signals.

The Main channel features three plugin slots. Main plugin slots are well suited to effects such as equalizers and limiters, which can add some polish to the final sound of your Preset. A limiter can also help prevent clipping in the output of the V-Machine.

The gain and pan controls in the Main channel operate exactly like those in the other Mixer channels.

5.8.10 BPM Control
Using the BPM control above the master fader, you can set the tempo of the VFX Application’s internal MIDI clock. This tempo will be used by any plugin that can respond to external tempo sync. For it to work, the tempo sync must be switched on in the plugin. (See the plugin’s manual for details.)

This field corresponds to the Tempo parameter in the Preset. To see the Tempo parameter, scroll the parameter field in the V-Machine (either the hardware unit or the V-Machine Pane in the software) almost all the way to the left.

5.8.11 Time Signature
A few plugins that have tempo-based features (such as LFOs that can be synced to MIDI clock messages) may also be able to request the time signature of the host. The V-Machine’s Mixer provides a time signature parameter for this purpose. You can set the denominator of the time signature (the lower number) to 2, 4, 8, or 16 and the numerator (the upper number) to any number between 1 and 32, depending on the meter of your song.

5.8.12 Master MIDI Channel
The MIDI Channel setting in the Mixer controls the channel(s) on which the Mixer will respond to MIDI control messages. This parameter is available only in the VFX Application; it cannot be set from the V-Machine’s panel. Normally the Mixer MIDI channel can be left set to ALL. There might be a specific situation, however, in which you would need to set the Mixer to respond on a particular channel so that you can re-use the same CC messages on different channels for other purposes. (This is especially likely to happen if your hardware controller has only one CC source, such as a mod wheel, with which to send these messages.)

Program change messages that arrive on the Mixer’s channel will be used by the Mixer to
switch to a different Preset. Because of this, it would make no sense for the program change message to then be passed on to the plugins; the programs they will use will already be set up by the Preset. If the Mixer's MIDI channel is set to ALL, this means that no program change messages will ever be sent on to the plugins. In consequence, if the Global System Settings menu option MIDI Options: Send Program Change is set to “to Preset, then Plugins,” this setting will have no effect when the Mixer channel is set to ALL.

5.9 Parameter Pane
The Parameter Pane is designed to display the editable parameters of the currently selected plugin. It provides two displays. By default, you'll see the parameter grid. This is a list of the plugin's parameters, with a horizontal slider next to each parameter allowing it to be edited.
If you select Show VST Editor in the main menu, the graphic user interface of the selected plugin will appear in a floating window above the VFX Application window. (In the Macintosh, this window will be in the X11 layer of the OS, but this should make no practical difference when you're using the software.) All parameter adjustments that you make in the user interface of the plugin will be displayed in parameter grid, and vice-versa. If you have selected the matching parameter in the V-Machine Pane's Parameter name area, you'll also see the parameter value change in the V-Machine Pane's Value field.

The left column of the parameter grid holds the Priority buttons. You can click on any of these to highlight it. Priority parameters will be moved to the left end of the parameter list when the Preset is exported to the V-Machine. This is extremely useful for keeping your favorite parameters readily accessible. The priority parameters for all of the plugins in the Preset will appear in the V-Machine's parameter list immediately after (to the right of) the patch select parameters. Since a modern plugin may have more than a hundred parameters, scrolling through them on the V-Machine can take time, so get in the habit of using the Priority buttons for sound controls that you use often, such as filter cutoff and envelope attack time.

5.10 VFX Application File Management
The file management functions of the VFX Application are found in the File and Bank areas of the main menu. Developing good file management skills will enable you to create Banks of your favorite Presets efficiently and without confusion. While only one Preset is actually loaded into the VFX Application (or into the V-Machine) at a time, if your Library contains hundreds of Banks it will be harder to find what you're looking for. Naming the Banks will help, as will organizing your sounds into several smaller Libraries rather than one large Library.

Quick Tip: Creating Banks specifically for certain performances can make things very easy when synchronizing to the V-Machine or saving the Application status (Export to VFX Library) to a USB drive/stick. To do this, you would give each Bank a suitable name, such as Club, Wedding, or Concert. A single Preset could be saved to one Bank and then imported to other Banks as needed. If the source Bank is in the same Library, use the Clone Preset From command for this; if the source Bank containing the Preset is in a different Library, use the Import From VFX Library command in the File menu.

As a reminder: You don't have to do anything to save the current Library. Nor do you have to save a Bank to the Library. The Banks and Library are already resident on your hard drive (or on removable USB media, if you have chosen that location for your active Library). However, you do have to save each new Preset that you create, using the SAVE icon in the upper left corner of the main window.
5.10.1 Library File Management
All of your work in the VFX Application will be saved to the current Library as defined in the Options/Preferences dialog box. To create a new Library, go to the Options/Preferences box and use the Browse button to open a file dialog box. In the file dialog box, find the location where you want to create the new Library and type a folder name for it. (The folder name should end with the extension .vfxlibrary. This will be appended automatically if you don’t type it.)

Your new Library will initially be empty. Before you can create any Presets, you’ll have to import any plugins that you want to use. If you know that the new Library will need substantially the same plugins as an existing Library, it may be faster to use your computer’s file system to copy the existing Library folder and give the copy a new name. This will clone the entire Library, including its plugins, Presets, and Banks.

Note: In general, it’s a bad idea to use your computer’s file system to edit the contents of a .vfxlibrary folder. You should use the VFX Application itself to manage the Library contents. However, using the computer’s file system to make backup copies of your Libraries is highly recommended. The computer’s file system is also useful for rearranging the Banks within a Library, as explained in the next section.

5.10.2 Bank File Management
When you click on the Bank name in the V-Machine Pane, you’ll see a pop-up menu with the following five commands:

1. New Bank
2. Rename Bank
3. Delete All Presets in Bank
4. Delete Bank
5. Delete All Banks

You can also access the Bank file management features from the VFX Application’s main menu. For details, see the section 5.5.7.

These commands should mostly be self-explanatory. When deleting a Bank or deleting all of the Presets within the Bank (in effect, clearing the Bank) you’ll see a dialog box asking you to confirm your action. If you’re importing or exporting a Bank, a file browser or dialog box will appear allowing you to select the desired Bank (for importing) or Library location (for exporting).

There is no Clone Bank command. To make a copy of an existing Bank, create a new bank and then clone (copy) the Presets from the other Bank, one by one, into the new Bank.

There is no upper limit on the number of Banks that can be contained in a single Library.

Because the V-Machine will auto-load the first Preset from the first Bank in its stored Library each time it is turned on, you may find it helpful to put the Banks within a Library in a certain order. (This is also a good idea if you want to be able to step from one Bank to another onstage during a set where the songs will be in a known order.)

The VFX Application provides no direct tools for reordering Banks. You could create a new Bank, then clone all of the Presets from another Bank into the new one, and then delete the old one, but this is time-consuming and error-prone. Here’s a better solution: First, quit the VFX Application. Then find the Library folder on your hard drive and open it. Within the Library
folder you’ll find a folder called banks. Inside this is a series of folders, one for each Bank. The folder names begin with three-digit numbers, starting with 000. Carefully renumber the folders in the order you would prefer, making sure to put an underscore character after the number. When you're finished, restart the VFX Application. The Banks will now be in a new order.

5.10.3 Preset File Management

The file management features for Presets in the VFX Application are as follows:

- Clear Preset
- Rename Preset
- Clone Preset From...

These commands are available both in the pop-up menu when you click on the Preset name in the V-Machine Pane and in the Preset submenu in the main menu, and are explained earlier in this chapter, in the section 5.5.7. The SAVE icon is also essential in managing Presets, as it stores the current Preset into the Library. You will not see a dialog box asking for a location to which to save the Preset; it will be saved to its current location in the current Bank. Nor will you see an “Are You Sure?” message, so use this command with care. There is no “Save Preset As...” command. To do this operation, start by selecting an empty Preset, clone an existing Preset into it (as shown in Figure 34), then make your edits in the cloned copy and save it.

Note: The Preset pop-up menu will appear in the V-Machine Pane even if you have used the arrow buttons in the second row to move to a different preset, but have not yet clicked the Load button. If the words Load and Back are visible, you can open the menu and issue a command, but some of the menu commands won't work.

Clearing a Preset will remove all of its Plugins and Mixer settings. It will be renamed Empty Preset. (Note that clearing the Preset will not remove its plugins from the Library. They will still be available in other Presets.)

It’s always a good idea to use the Rename Preset command before saving the Preset. Choose a short, descriptive name such as “EP/String Layer.” The exact number of letters you’ll be able to see displayed in the name depends on the width of the letters.

New Presets don’t have to be created. Each Bank starts with 128 Presets, all of them empty. To start working with a new Preset, simply use the right arrow in the second row of the V-Machine Pane to scroll to a Preset with a default name (such as Preset 2) and click the arrow button beside the word Load.

Cloning existing Presets is a great way to quickly configure new Presets. Cloning duplicates all of the settings of another Preset, including plugin selections, MIDI settings, and Mixer settings. You can clone a Preset by clicking your mouse on the Preset name displayed in the V-Machine Pane and selecting Clone Preset From in the menu.
Cloning a preset.

Special Note: Preset files are stored in the .vfx file format. This file will be found by following a file path that looks something like this:

Users > Libraries > Music > My Music > VFX Library.vflibrary > banks > 000_Bank Name.vflbank > 000_Preset Name.vflpreset > preset.vfx

If you are interested, you can open this Preset file in a text editor like WordPad to see how the Preset file is put together. Understanding the Preset file format might be useful in situations where you do not have access to a computer with the VFX Application installed, but need to edit a Preset manually. However, most of the parameters that you might want to edit here can also be edited from the front panel of the V-Machine, so there will seldom be any need for you to do this.

5.11 Synchronization or Export of the Active VFX Library

Synchronization and exporting are both ways of transferring Banks, Presets, and Plugins prepared in the VFX Application on your computer to the V-Machine for music performance. The difference between synchronization and exporting is this: When you synchronize the VFX Application with the V-Machine, all of the data in a Library is transferred directly into the V-Machine’s Flash (long-term, non-volatile) memory over a USB cable. When you export a Library, it is stored on external media, such as a hard drive or USB memory stick. After the Library has been exported, you can disconnect the external drive or memory stick from your computer and plug it into the V-Machine.

Exporting and synchronizing are similar — but when you need to load new plugins into the V-Machine, exporting is faster, because transmitting large amounts of data over a USB connection to the V-Machine is slow. In addition, you can export Libraries that are many gigabytes in size, larger than the total available memory of the V-Machine. When you synchronize, the Library can be no larger than the amount of memory in your V-Machine. For both reasons, you should most often export rather than synchronizing. Synchronization can be useful, however, if you have no external hard drive or USB memory available for exporting.

Exporting is also useful because you can export a different Library to each of several different hard drives or memory sticks. You can then “hot-swap” onstage, detaching one Library and
attaching another between songs or sets so as to be ready with a different set of Presets. (Each time you hot-swap, the V-Machine will auto-load the first Preset in its first internal Bank from Flash memory, so changing to a different USB memory device will take up to 30 seconds.)

Exporting is not always a fast process. When a Library is exported, all of its plugins and all of their associated data files (such as sample libraries) have to be copied to the external drive. Depending on the amount of data involved, this can take several minutes. There are ways to speed up the process, as explained in the next section.

The V-Machine’s internal Flash memory is 1GB in size. A small portion of this memory is dedicated to the operating system, so the full 1GB is not available for Library use.

5.11.1 Exporting to a VFX Library
Selecting File > Export to VFX Library from the main menu will open a file browser, in which you can select components of the currently active VFX Library to export to an external storage location. You can select the entire Library (by clicking on All Banks), or a single Bank and all of its Presets (by clicking on the name of the Bank), or a single Preset (by opening a Bank to display the Presets within it, and the clicking on a Preset name).

If your external media already contains a VFX Library, you can merge the Preset or Bank(s) that you’re exporting with the existing Library. To do this, simply choose the folder of the existing Library when the file save dialog box appears. You will then see another Library file structure box that will let you choose where in the existing Library to store the data that you’re exporting.

To export a Preset, Bank, or Library:

- Select File > Export to VFX Library from the main menu (see Figure 35).

- A dialog box (see Figure 36) will prompt you to choose an item from the active Library to export. It is possible to choose All Banks, an individual Bank, or an individual Preset.

- You can choose to export your selected item with or without the associated plugin(s). In addition, you can choose to keep existing plugins or overwrite them. If you are merging Banks or Presets into an existing VFX Library that already contains the plugin and associated files, uncheck the “With Plugins” checkbox in the Export to VFX Library box. This will make the export process run faster, because the data for the plugins won’t need to be copied to the external media. Keep in mind, however, that if you uncheck the “With Plugins” box and merge a Bank or Preset into a Library that does not contain the associated plugins, the Library will not function correctly on the V-Machine hardware, because one or more plugins will be missing.

- Click Export to bring up a Windows file browser (see Figure 37) where you can name and choose the location of a new VFX Library, or alternatively select a previously created VFX Library you wish to merge your exported items into. Once you have set a new name or selected a previously created Library, select Export to complete the task.

- If you are merging a Bank into a Library that already has a Bank with the same name, you will see a dialog box that asks whether you want to overwrite the existing bank or create a new one. If you choose to create a new Bank, a number will be added to the Bank name (such as “Wedding Strings 2”).
Figure 35
Choosing the Export to VFX Library command from the main menu.

Figure 36
Choosing items to export.
Choosing the Library folder to which you want to export the Bank(s) or Preset(s).

To use the Library that you have exported, remove the USB memory device where it is stored and connect that device to the V-Machine to access the Banks and Presets contained within.

**Note:** External media (USB drive or memory stick) can contain more than one Library. When the drive is connected to the V-Machine, the V-Machine’s Bank left/right buttons will step through all of the Banks in all Libraries on the connected device. If Banks in separate Libraries have the same name, however, there’s some room for confusion. For this reason, it’s a good idea to give each Bank a unique name, or to keep only one Library on each external USB drive.

**Important Tip!** – Always safely remove USB memory devices from your host computer to avoid corruption of VFX libraries. A corrupted library will not work successfully on the V-Machine.
Quick Tips:

- After Exporting to an external device, you can browse the VFX Library from your computer's operating system to see the contents of the Banks and Presets. This can be useful if you wish to check the size of a particular Bank, Preset, or plugin. This information can assist with your decision to either keep files on the memory device or transfer to the internal Flash of the V-Machine using the export method, as described above.

- You can also export a Library to a location on your computer's internal drive and then use the computer's operating system to copy the Library to external media. Exporting directly to the removable drive or memory stick is usually faster, because the data will only have to be copied once rather than twice.

5.11.2 USB Synchronization Method to the V-Machine’s Internal Flash Memory

Clicking the SYNC icon in the VFX Application's command bar (see Figure 38) initiates one of two processes, based on your input and the VFX Application's automatic detection of a connected V-Machine.

Figure 38

The SYNC (synchronize) button.

- If a V-Machine is connected and has enough available memory in its 1GB Flash memory bank, clicking the SYNC button will cause the currently active Library to be transmitted directly to the V-Machine over USB and stored in Flash.

- If no V-Machine is connected, or if not enough memory is available, clicking the SYNC icon initiates the export process, as described in the previous section.

Synchronization via USB cable allows you to transfer a selection (or all) Banks, Presets, plugins, and associated files (samples and configuration files) to the V-Machine’s 1GB internal Flash memory. It is possible to synchronize or Export Banks and Presets individually, or the entire VFX Library at one time.

Choose the items you would like to transmit to the V-Machine from the Synchronize dialog box (see Figure 39), click the Sync button, then click Sync again in the pop-up confirmation box.
Choosing items to send to the V-Machine using synchronization.

The VFX Application checks the size of the VFX Library components you're requesting to synchronize and compares them with the available memory on the V-Machine. A dialog box will advise you prior to synchronization if your export data exceeds the available memory allocation of the 1GB of internal Flash memory.

An approximation of the time it will take to synchronize over USB is calculated. If you decide that the estimated time for synchronization over USB is too long, you can choose to export to a VFX Library on a USB memory device for use on the V-Machine instead. Remember, large plugins with a lot of supporting files (like samples) can take a very long time to synchronize over USB. Exporting to a VFX Library is faster.

Note: Synchronization over USB cable does not run at full USB bandwidth, as it transfers data using the MIDI system-exclusive protocol. This is why it is considerably faster to export when the Library is large.

Recommendations/Notes:

- Keep in mind that when using the USB synchronization method, you are limited to approximately 1GB of memory space as per the V-Machine’s flash memory.
- The USB synchronization method is most useful for synchronizing individual Presets or small Banks that use Plugins that already reside on the V-Machine’s internal flash memory.
- The USB synchronization method can be considerably slower than the Export VFX Library method. This is especially true with a large amount of data (such as plugin sample libraries).

5.12 Uninstalling the VFX Application

To uninstall the VFX Application from Windows, run the Windows Add/Remove Program application (called Uninstall in Windows 7) from the Windows Control Panel. Select the VFX Application and remove it.

To remove the VFX Application in the Macintosh, simply drag it from the Applications folder
into the Trash.

6 Limitations

- The V-Machine is based on a custom operating system. VST plugins are intended to run on Microsoft’s Windows operating system. Some VST plugins may not function correctly or at all on the V-Machine. This can happen for several reasons: For example, the plugin may require more RAM than the 500MB available on the V-Machine, or it may use a form of copy-protection that is not compatible with the V-Machine. If you already own the plugin, the easy way to determine whether it is compatible with the V-Machine is to import it into a Library and try it. If you are thinking of purchasing a plugin for use with the V-Machine, check the SM Pro Audio website or consult your local V-Machine dealer to determine whether the plugin is known to work with the V-Machine.

- Performance of the V-Machine and the VFX Application may be limited by the amount of RAM, non-volatile memory, and CPU speed.

- Display of VST custom GUIs (graphic front panels) will usually work in the VFX Application, but some plugins with special graphics needs may not display their panels correctly. Their parameters should still be displayed in the VFX Application’s parameter list, however.

- Not all VST Plugins can be loaded onto the V-Machine by simply copying the .dll files to a USB memory stick. Many VST plugins demand complex installation procedures. SM Pro Audio maintains a large database of Wizard Files, which handle the details of importing plugins into Libraries. However, it’s possible that no Wizard File will be available for the plugin you want to use, or that the Wizard File may be compatible only with a different version of the plugin. Support for plugins utilizing custom installation procedures may be limited or only supported in future updates of the VFX Application.

7 Warranty

The SM Pro Audio warranty covers all defects in material and workmanship for a period of 12 months from the date of original purchase. This warranty does not cover defects due to abuse, faulty connections or operation under other than specified conditions. Warranty coverage is voided if the device is repaired by unauthorized persons or tampered with in any way. SM Pro Audio reserves the right to refuse all warranty claims if the product was not sold from an authorized dealer to the respective end customer.

This warranty is limited to replacement or repair of the product. It does not limit the customers’ rights according to the current product liability regulations of the country where the product was purchased.

The warranty is only valid if the customer has registered the product via a valid SM Pro Audio registration method as outlined below.

Electronic registration – Register the product purchase online at http://www.smproaudio.com.
Postal registration – Take a copy of your purchase receipt and and mail it to your closest SM Pro Audio distributor along with your name, address, and email address. (A current list of distributors is to be found on the SM Pro Audio website.) The product warranty registration form will request such purchase details including serial no., date of sale, Dealer name, as well as name and address of the customer.

If a defect occurs during the warranty period, contact the point of purchase or write an email to warranty@smproaudio.com

The V-Machine can only be returned once approval has been sought and the following conditions are met:

1. The unit is returned in its original package.
2. A detailed description of the defect and a copy of the purchase receipt are included.

All shipping costs are the responsibility of the end user.

8 Trademarks
V-Machine and Powered by VFX are trademarks of VFX Systems Pty Ltd, Australia.

ASIO and VST are trademarks of Steinberg Soft- und Hardware GmbH.

Windows is a registered trademark of Microsoft Corporation in the United States and other countries.

Mac, Mac OS and Macintosh are trademarks of Apple.

The Kensington lock is a registered trademark of Kensington.

iLok is a registered trademark of Pace.

eLicenser is a trademark of Syncrosoft.

Other company and product names may be trademarks of their respective owners.

9 FCC and CE Regulation
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Caution: Any changes or modifications in construction of this device that are not expressly approved by the party responsible for compliance, could void the user's authority to operate equipment.

Note: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful
interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his/her own expense. If necessary, consult an experienced radio/television technician for additional suggestions.

Special Note: In the presence of strong electromagnetic interference, the V-Machine may cease to function. Cycle the power off and on to resume operation.

10 Correspondence
For technical support, warranty claims, and all other enquiries, please contact your local SM Pro Audio distributor. Contact details of all SM Pro Audio distributors list can be found online at http://www.smproaudio.com.
11 Appendix B: Troubleshooting

11.1 Symptom: No Sound

Things to check:

- Is the V-Machine powered up?
- Are the outputs of the V-Machine connected to your audio system?
- Is your audio system powered up?
- Is the channel of your audio mixer to which the V-Machine is attached turned down or muted?
- Have you connected a MIDI cable from the output of your keyboard to the V-Machine’s MIDI input?
- Is your keyboard transmitting on the MIDI channel that the V-Machine expects to receive on?
- Is the V-Machine’s internal Mixer channel for the active Preset turned down or muted?

11.2 Symptom: Sound Is Distorted

Things to check:

- Is the signal from the V-Machine overloading the input of your sound system? Try turning down the output volume of the V-Machine Mixer using the Mixer Master Gain parameter or the Output Gain parameter in the Global System Settings menu, or lower the input trims on your sound system’s channels.
- Are you using so many simultaneous plugins that the V-Machine’s processor can’t keep up? Scroll the parameter setting all the way to the left, to VFX Buffer Size, and try increasing the number of samples in the buffer. (Increasing the buffer size will also increase the amount of time the V-Machine needs to respond to incoming MIDI messages.)
- Is the signal from an instrument plugin overloading the input of an effect plugin in the same mixer channel? Find the master output gain parameter for the instrument plugin and try lowering it.
11.3  **Symptom: Bank, Preset, or Plugin Not Found on V-Machine**

Things to check:

1. Save the Library from the VFX Application to an external USB memory device, safely remove the USB device from your computer, connect the USB memory to the V-Machine, and re-import the missing component(s). Always safely remove USB memory devices from your host computer to avoid corruption of VFX libraries. A corrupted library will not work successfully on the V-Machine.

2. If the plugin requires more memory (such as samples) than is available in the V-Machine, try running it directly from the external memory.

11.4  **Symptom: VFX Application Can’t Find V-Machine**

Things to check:

1. Is the computer connected to the V-Machine using the “to host” (square) USB jack on the V-Machine’s rear panel?

12  **Mac OS X – Troubleshooting**

12.1  **Symptom: VFX Application will not start on OS X**

Things to check:

1. Check that you are running OS-X version 10.5 (Leopard) or later. The VFX application will not run on earlier versions of OS-X. If you are running an earlier version of OS-X, then you will need to update it.

2. When running on a Mac, the VFX application depends on two important programs in order to run VST plugins for Windows. These programs are X11 and Wine. If either of these is malfunctioning, then the VFX application will not work correctly. You can check that these programs are working by following the steps under "Check your OS-X installation" and "Check your Wine configuration".
**12.2 X11 Installation considerations**

X11 is a graphics display program that runs on nearly all types of modern computers. The VFX Application on a Mac uses X11 to show the graphical interfaces for Windows VST plugins.

1. Follow the following steps to check X11 is running correctly on your Mac.
2. Run the OS-X "Terminal" application, found in the "/Applications/Utilities" folder.
3. In the terminal, type "xclock" and press the return key.

If a window with a clock appears, then X11 is working on your Mac. If you get an error message or do not see a clock, then X11 is not working correctly.

On OSX 10.5 and above X11 is installed on your Mac by the OSX operating system installer. You may be able to fix it by copying a working X11.app installation, from another Mac with the same operating system as yours, over the top of your broken one in /Applications/Utilities/X11.app.

If that does not work then you may need to reinstall your operating system using the instructions provided with your Mac.

**12.3 Wine configuration considerations**

Wine is a program that lets Windows applications run on non-Windows operating systems. The VFX Application uses Wine to run Windows VST plugins on your Mac and on your V-MACHINE.

The V-MACHINE itself keeps it's Wine installation minty fresh by resetting it every time the V-MACHINE is powered on. However on the Mac it can become corrupted with time after a lot of use running Windows programs.

If your wine configuration becomes corrupted, you may see behaviour ranging from certain plugins not working, to the VFX application itself not working.

Follow the following steps to check your Wine configuration is working correctly on your Mac.

1. Quit the VFX application if it is running and rename the Wine virtual Windows environment inside your "Music" folder from "VFX Wine VM.vfxwinevm" to some temporary name. This will cause the VFX application to create a fresh Wine environment when it next starts up.
2. Run the VFX application. If the VFX application fails at this point, then there is a more serious problem than a corrupt Wine installation. Try following the steps under "Check your X11 configuration", and if that doesn’t help, delete the VFX application and re-install it.
3. Try and install the plugin you want to work inside the VFX application, now that it is running with a fresh Windows environment. If you install using a VFX plugin wizard in the "Import Plugin" screen, and have updated to the latest wizard database in that screen, and use the plugin's default installation options, then the plugin should now work.

If the plugin still doesn't work, then check the latest V-MACHINE supported plugins list online and make sure it is supported. If it is not then you may have some luck searching internet forums, or writing your own VFX plugin wizard for that plugin.